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Student Resource 1.1 

Anticipation Guide: Web Design  

Student Name:_______________________________________________________ Date:___________ 

Welcome to the AOIT Web Design course! Over the next few months, you’ll learn a great deal about the 
job of a website creator, whose role may include project planning, designing, building, or writing content 
for websites. Perhaps even more important, you’ll learn and practice real-life web development skills that 
you can use today, such as choosing and using web development tools, planning and building a website, 
and attracting visitors to your site.  

This is a hands-on course. That means you’ll not only learn facts and concepts, but also have lots of 
opportunities to practice what you learn, including creating your own website. You’ll also get to meet a 
number of professionals in the web industry. They will give you an opportunity to find out if website 
creation or related professions such as graphic design, project management, and content writing are 
careers you’d be interested in pursuing. 

Directions: For each of the statements below, underline “I agree” if you think the statement is accurate 
and “I disagree” if you disagree with it. Write one reason to explain your guess. 

A website’s success is determined by how many visitors it has. 

My guess:     I agree             I disagree 

My reason:  

I learned: 
 

 

The most important information that designers need to know to build a successful website is 
what the goals are for the site. 

My guess:     I agree             I disagree 

My reason:  

I learned: 
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The best way to design a website is to start by studying another one with similar goals. 

My guess:     I agree             I disagree 

My reason:  

I learned: 
 

 

All websites work equally well on all browsers. 

My guess:     I agree             I disagree 

My reason:  

I learned: 
 

 

Good websites will gain popularity easily and don’t need to be promoted. 

My guess:     I agree             I disagree 

My reason:  

I learned: 
 

 

There are many different types of career opportunities in the web industry, and many new 
opportunities are developing in the field. 

My guess:     I agree             I disagree 

My reason:  

I learned: 
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Student Resource 1.2 

Taxonomy: Web Design Terms 

Student Name:       Date:    

Think of terms related to the topic of web design. Write them on this list in alphabetical order. 

A  

B  

C  

D  

E  

F  

G  

H  

I  

J  

K  

L  

M  

N  

O  

P  

Q  

R  

S  

T  

U  

V  

W  

X  

Y  

Z  
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Student Resource 2.1 

Reading: Creating PowerPoint Presentations 

 

This presentation explains the best practices in content and design for making PowerPoint presentations. 
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PowerPoint presentations give you an opportunity to disseminate information in a visual and oral way to 
your audience. Keep the slides simple and add important and interesting information like examples and 
explanations as you speak. 
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All these features make your PowerPoint presentations easy to read from anywhere in the room. 
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Learning objectives are the important points you want everyone to remember. Explain them and add 
more detail in the notes than what is on the slide. Some students retain information better by seeing it, 
some by hearing it, and some by writing it down, so ask everyone to take notes. Do not be afraid to 
repeat important information. 
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While it can be tempting to make slides with lots of graphics, fancy fonts, and animation, remember that 
the purpose of a PowerPoint slide is to convey information clearly. Use graphs and charts to illustrate 
numerical data; use pictures and clip art that enhance the information. Use animation only when 
necessary. Remember to avoid putting information on a slide that doesn’t relate to the content or that 
could confuse the audience. When it comes to PowerPoint, simple is best.  
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Your presentation gives you the opportunity to use examples and to include other supplemental 
information that will help your audience relate to the information. Use your own words—don’t just read the 
slides. You can use the Notes portion of each slide to write notes about what you want to say when you 
present the slide. 

When you speak, make sure you are facing your audience and looking at them; avoid turning your back 
to your audience and looking at your slides. Pause after each slide to give your audience time to take 
notes. You might consider saying, “What are your questions?” instead of “Do you have any questions?” 
after each slide. Often, when we ask, “Do you have any questions?” people automatically say, “No.” Also, 
if you have time, you can ask the audience to share information that will enrich the discussion. 
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The final slide should summarize what the other slides said. Do your best to make the presentation 
interesting to your audience, but remember that the number-one goal of a PowerPoint presentation is to 
give out information clearly! 

 

 



AOIT Web Design  
Lesson 2 Looking at the World Wide Web 

Copyright © 2008–2015 National Academy Foundation. All rights reserved. 

Student Resource 2.2 

Research Outline: Presentation Topics and Subtopics 

Directions: This resource provides a list of subtopics for you to explore in your research for your 
PowerPoint presentation. Your presentation should cover the topics listed in the outline for your topic as a 
minimum. Use the list of relevant websites in Student Resource 2.3, Reference List: Relevant Websites 
for Research Projects, to research your topic. Feel free to add any information you find particularly useful 
or relevant.  

Topic 1: How the web works and how documents are transferred  

1. How information is shared on the Internet 

a. Web 

b. Email 

c. FTP 

d. Social media and other web communication channels such as Facebook and Twitter 

2. How documents are connected to each other via hypertext links, creating a “web” of information 

a. Websites 

b. Web pages 

c. Home pages 

d. Actual documents such as PDFs and forms 

3. How data and documents are transferred using standardized methods called protocols  

a. HTTP 

b. HTTPS 

c. Role of World Wide Web Consortium (W3C) in developing standards 
 

Topic 2: The roles that computer servers and browsers play in how the web works 

1. Definitions of server and browser 

2. URLs  

a. Definition/purpose of URL 

b. Parts of a URL 

c. Purpose of index/default files 

d. URL aliasing 

3. How browsers display pages 

4. How mobile browsers display pages 
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Topic 3: How web pages are made 

1. HTML 

2. CSS  

3. Site maps 

4. Navigation 

5. Flash 

6. JavaScript 

7. PHP, ASP, or Ruby on Rails  
 

Topic 4: How e-commerce works 

1. Technical transaction process including secure (HTTPS) transactions using a certificate (SSL) 

2. Advantages of e-commerce 

3. Potential dangers of e-commerce 

4. XSS 
 

Topic 5: How the web was developed 

1. Short history of the web 

2. The dot-com crash (end of the Web 1.0 era) Web 2.0 

3. Current trends in web development (include mobile development) 
 

Topic 6: How social networks are developed 

1. What are social networks? 

2. History of social networks (before the Internet) 

3. What do people use them for? 

4. Possible impacts of social networks 
 

Topic 7: How mobile websites are developed 

1. What is a mobile website? 

2. What are the differences between a mobile website, a responsive website, and a mobile app? 

3. What are the pros and cons of a mobile website vs. a responsive website? 

4. What is different about designing for the mobile web? 

5. Issues with smaller screen sizes and imprecise finger tapping 
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Student Resource 2.3 

Reference List:  
Relevant Websites for Research Projects 

“A Little History of the World Wide Web,” World Wide Web Consortium (W3C). 
http://www.w3.org/History.html 
Covers 1945 to 1995. 

“20 Things I Learned about Browsers and the Web,” Google Chrome Team. 
http://www.20thingsilearned.com/en-US/home  
An introduction to web and browser terminology. 

“How Does the Internet Work?” WiseGeek. 
http://www.wisegeek.com/how-does-the-internet-work.htm 

“How the Internet Really Works,” NetLingo. 
http://www.netlingo.com/more/cerfart.cfm 
An easy-to-understand article by Vinton Cerf that summarizes how the Internet works. 

“How Internet Infrastructure Works,” Jeff Tyson, HowStuffWorks. 
http://computer.howstuffworks.com/internet-infrastructure.htm 

“The Causes of the Dot Com Crash,” Ryan P. Allis, ZeroMillion.com. 
http://www.zeromillion.com/econ/dot-com-crash.html 

“Market Crashes: The Dotcom Crash,” Andrew Beattie, Investopedia. 
http://www.investopedia.com/features/crashes/crashes8.asp 

“How Ecommerce Works,” Paul Ciszewski, FindMyHosting.com. 
http://www.findmyhosting.com/how-ecommerce-works/ 
A short, illustrated summary of how transactions occur in online business. 

“How E-commerce Works,” Marshall Brain, HowStuffWorks. 
http://communication.howstuffworks.com/ecommerce.htm 

“What Is Web 2.0?” Tim O’Reilly, O’Reilly Media. 
http://www.oreilly.com/pub/a/oreilly/tim/news/2005/09/30/what-is-web-20.html 
The first page provides examples of Web 1.0 vs. Web 2.0 characteristics.  

“Social Network Sites: Definition, History, and Scholarship,” Danah M. Boyd and Nicole B. Ellison, Journal 
of Computer-Mediated Communication.  
http://onlinelibrary.wiley.com/doi/10.1111/j.1083-6101.2007.00393.x/abstract  

“Guidelines for Mobile Web Development,” Smashing Magazine. 
http://www.smashingmagazine.com/guidelines-for-mobile-web-development/  

“Separate Mobile Website vs. Responsive Website,” Brad Frost, Smashing Magazine. 
http://www.smashingmagazine.com/2012/08/22/separate-mobile-website-vs-responsive-website-
presidential-smackdown-edition/  
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Student Resource 2.4 

Assignment Sheet: PowerPoint Presentation 

Directions: Use the guidelines below to create a three- to four-minute PowerPoint presentation about your 
web development topic. Then prepare as a group to present your presentation to the class. Review the 
assessment criteria before you begin your work. 

Guidelines 
 Divide up your outline among group members, and give each group member the responsibility to 

create slides for specific items in the outline. 

 Make sure each slide contains a manageable chunk of information. Use as many slides as 
necessary to get the information across clearly.  

 Include examples and illustrations. 

 Use the Notes sections of the slide for background information that you want to tell the audience 
about. 

 As a group, check each slide to make sure it is clear and concise and contains only the bullet 
points necessary.  

 Check your presentation while you are working to ensure that you have included all the necessary 
elements in the presentation.  

 Choose one or more members of your group to present to the class.  
 

Make sure your presentation meets or exceeds the following assessment criteria: 

 Each slide has a meaningful title that enhances understanding of the topic. 

 Each slide has clear, easy-to-read, and easy-to-understand content.  

 The presentation provides essential and accurate information about the main points of the subject. 

 The images and graphics are clear, relevant, and helpful.   

 The presentation includes contributions from all group members.  

 The presentation is engaging, and each slide is accompanied by relevant explanations rather than 
just a word-for-word reading of the slide. 

 The presenter faces the audience and establishes eye contact. 

 The presentation is neat, with no grammatical or spelling errors. 
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Student Resource 2.5 

Guidelines: Cornell Note Taking 

Directions: Cornell Notes is an effective system that has been in use since the 1950s. Use this method or 
the one your teacher instructs you to while listening to your classmates’ presentations to get the essential 
information you need on paper. For Cornell Notes, divide your page into two columns. During the lecture, 
summarize what you hear in the right-hand column. After the lecture, pull out the important words, 
phrases, and definitions and write them in the left-hand column so that you can use them as prompts. 
Then follow steps two through five listed below to help you study. 

Left-Hand Column 
 

Important words, 

phrases, and  

definitions. 

Right-Hand Column 
 

Step one, during the lecture or presentation: 
Record what you hear in short, summarizing 
sentences. 

 
Step two, immediately after the presentation: 
Write questions about what you’ve heard to help 
you remember the information and to help you 
study later. 

 

Step three, when you’re studying: 
Cover the right-hand column and recite what you 
remember by looking at the important words, 
phrases, and definitions. 

 

Step four, before tests and quizzes: 
Reflect on the notes and ask yourself questions 
about them like: What is important about this 
concept? How do these ideas fit with what I 
already know? 

 

Step five, every week: 
Review all your notes for at least 10 minutes. 

 

Bottom of the Page 
After class, summarize the notes you took at the bottom of each page. 
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Student Resource 3.1 

Chart: Website Categorization 

Student Name:_______________________________________________ Date:___________ 

Directions: An early step in designing or evaluating a website is clarifying the main purposes of the 
website. There are millions of websites, and most of them can be categorized into one or more of the 
following purposes. Listen carefully and take notes in the Characteristics column as your teacher 
discusses and gives examples of each type of website. Then, look at your class list of websites and list 
each site in its proper category.  

Website Categories 

Category and Examples Characteristics 

Web Portal: 
Example websites: 

 

 

 

Search Engine: 
Example websites: 

 

 

 

Informational: 
Example websites: 
 

 

 

News:  
Example websites: 
 

 

 

Commercial (E-commerce): 
Example websites: 
 

 

 

Educational: 
Example websites: 
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Category and Examples Characteristics 

Entertainment: 
Example websites: 
 

 

 

Advocacy: 
Example websites: 
 

 

 

Blog: 
Example websites: 
 

 

 

Personal:  
Example websites: 
 

 

 

Social Networking (Community):  
Example websites: 
 

 

 

Social Bookmarking: 
Example websites: 
 

 

 

Video/Media Sharing: 
Example websites: 
 

 

 

Wiki: 
Example websites: 
 

 

 

Financial Transaction: 
Example websites: 
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Student Resource 3.2 

Analysis: Successful and Unsuccessful Websites 

Student Name:_______________________________________________ Date:___________ 

Directions: Follow the instructions below to analyze what makes a website successful. First you will look 
at a successful site, and then you will look at an unsuccessful site. Keep this analysis worksheet to help 
you when you write your compare-and-contrast web design paragraph (Student Resource 3.3).  

Successful Site 
 Enter http://www.awwwards.com/awards-of-the-day in your web browser to access a site 

sponsored by Awwwards. This site recognizes and promotes the talent and effort of web 
designers, developers, and agencies that create unique digital experiences that are useful, 
innovative, intuitive, and beautiful.  

 Click any award-winning site that looks interesting to you. 

 Fill out the chart below, which includes the criteria on which each site was judged. For each of the 
characteristics listed, write specific comments about the site you chose. For instance, for Usability, 
write the ways the site is easy to use (easy-to-identify links, logical names of categories, obvious 
navigational bar—write down the details). Use the notes in your notebook along with your 
taxonomies to help you come up with the right words. 

Name of website:                                                Date when it won an award: 

URL  

Comment on the following characteristics for this site: 

Design  

Creativity   

Usability  

Content  
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Unsuccessful Site 
Now enter http://www.angelfire.com/super/badwebs in your browser and complete this portion of the 
worksheet. 

Type of site (category)  

Comment on the following characteristics for this site: 

Design 

 

 

Creativity  

 

 

Usability 

 

 

Content 

 

 



AOIT Web Design  
Lesson 3 Exploring Websites 

Copyright © 2008–2015 National Academy Foundation. All rights reserved. 

Student Resource 3.3 

Writing Assignment: Evaluating Web Design 

Directions: Write a paragraph comparing and contrasting the successful site you looked at with the 
unsuccessful site you looked at. Use your analysis and notes from this lesson to help you form your 
comparison. Review the example that is part of this resource to get ideas about how to structure your 
paragraph. Before you start working, review the assessment criteria and make sure you understand how 
your work will be assessed. 

What Your Paragraph Should Include 
 A topic sentence that gives an opinion that is interesting and provocative 

 At least two examples of successful web design practice (ease of use; satisfaction of user needs; 
clear and accessible information; effective communication capabilities; memorable, unfussy 
design) 

 At least two examples of unsuccessful web design practice  

 Two or three sentences that use your examples to compare and contrast successful and 
unsuccessful web design 

 At least one sentence that expresses your opinion about successful and/or unsuccessful web 
design 

 A conclusion statement that gives some insightful information about your subject 

 

Make sure your paragraph meets or exceeds the following assessment criteria: 

 The paragraph compares and contrasts one website with successful web design to one site with 
unsuccessful web design. 

 The paragraph begins with a topic sentence that is interesting and provocative. 

 The examples of successful web design practices are clear and easy to understand. 

 The examples of unsuccessful web design practices are clear and easy to understand. 

 Comparisons and contrasts help the reader understand why one site is more successful than the 
other. 

 The paragraph ends with an insightful concluding sentence. 

 All text is neat, with proper spelling and grammar. 

  



AOIT Web Design  
Lesson 3 Exploring Websites 

Copyright © 2008–2015 National Academy Foundation. All rights reserved. 

Example: What Makes a Good Photograph? 
 

Some people might think it very appropriate that my tabby cat, Fred, has red, demon-like eyes in one of 
the photographs I have taken of him to put on my web page, but I don’t think that captures his character 
at all. I would rather put good-quality photos on my web page because that better represents my skills. A 
successful photograph is one that captures the subject and the moment and is in focus. An unsuccessful 
photograph misses the moment, shows the subject inaccurately, is blurry or too dark, or has other 
problems. My first picture of Fred meets several criteria of what makes a good photo. Everything is in 
focus, including the mouse trying to scurry away. The composition is balanced, with the cat just off-center 
to the left and the mouse off to the right. It captures the moment accurately. The second photo, on the 
other hand, is not so successful. Everything is slightly blurry, even though Fred was just sitting there. 
Fred’s eyes are glowing red, and the mouse is nowhere to be seen…possibly because it is hidden behind 
the large, very out-of-focus object on the right side of the screen—my thumb. Because the second 
photograph of Fred could make it look as if I don’t know my camera from a camshaft, I will be uploading 
only the first photograph onto my web page. A good-quality photograph such as this will not only 
represent Fred better, but also show that I can exercise good judgment as a web designer. 
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Student Resource 4.1 

Deduction: Deciphering HTML Code  

Student Names:_______________________________________________ Date:___________ 

Directions: Work with a partner and make your best guess as to what the different tags in this source 
code correspond to on Marina’s web page. In the table on the last page of the worksheet, write what you 
think each of the HTML tags means. Use your own knowledge of web design and your deduction skills. 
Your teacher will lead you through the first example. Once you have completed number 1 with your 
teacher, do numbers 2–10 with your partner. 

HTML Code for Marina’s Web Page 
 

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN" 

 "http://www.w3.org/TR/html4/loose.dtd"> 

<html lang="en"> 

  

 <head>  

  

  <meta http-equiv="content-type" content="text/html; charset=utf-
8"> 

  <meta name="Author" content="Marina S"> 

  <meta name="Description" content="This is a personal website that 
I've created to help myself learn html."> 

   

  <title>Marina's Web Page</title>  

  

   

 </head>  

 

<!-- I can write notes to myself that won't show up on the page. They are 
wrapped inside an html comment tag. Notes to self are mainly for code 
review purposes, so you don't forget who did what and why they did it (when 
the code is shared by many in a team). --> 

 

<body>  

 

<h1>Marina's Web Page</h1> 
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<div id="about"> 

 

 <h2>About Me</h2>  

  

 <p>I am a junior at King High School. I have been enrolled in the <a 
href="http://ait.echalk.com/">Academy of Information Technology</a> since 
my sophomore year and enjoy the program because it is preparing me for 
college and teaching me about one of my favorite things, 
<em>computers!</em> So far, I'm most proficient with MS Word, Photoshop, 
and Firefox.</p 

  

 <p>Once I finish high school, I will attend a four-year college and 
study Information Systems and/or Web Design. I will be doing my internship 
this year at the Franklin Bank, where I'll be keeping their computers virus 
free and updating their website. I am really excited to work with computers 
in a professional environment and increase my computer skills.</p> 

  

 <p>In my free time, I work at my parents' store and help take care of my 
little brother. I usually work 25 hours a week at the store helping stock 
the shelves and ringing up the customers. When we are not busy at the 
store, I have time to do my homework there, so I do have some extra time to 
train in karate, which I really love to do. I also like to play video 
games, knit, and help my friends fix their computers.</p> 

  

 <p><em>Thank you for visiting my page!</em></p> 

  

 <h3>My top favorite video games:</h3> 

 <ul>  

  <li>Nintendogs</li> 

  <li>Animal Crossing</li> 

  <li>Super Mario Galaxy</li> 

 </ul> 

  

</div> 

 

<div id="images"> 

 

 <h2>Pictures</h2> 

  

 <img src="karate.jpg" width="534" height="800" /> 

 <p class="caption">Here I am practicing karate!</p> 
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 <br /> 

 <img src="dogRufus.jpg" width="800" height="533" /> 

 <p class="caption">This is our dog Rufus.</p> 

  

</div> 

 

<div id="links"> 

 

<h2>My Favorite Websites</h2> 

 

<p><strong>Please take a look at my two favorite websites!</strong></p> 

 

<ul>  

  <li><a href="http://dogtime.com/">Dogtime.com</a></li> 

  <li><a href="http://www.youtube.com/">YouTube</a></li> 

 </ul> 

 

</div> 

 

<hr /> 

 

<div id="poem"> 

  

 <h2>Individual Choice</h2> 

 <h3>This is a poem I wrote:</h3> 

  

 <blockquote> 

  

 Without the sun<br /> 

 Without strength<br /> 

 Without a goal<br /> 

 I cannot thrive<br /><br /> 

  

 Without belief<br /> 

 Without faith<br /> 

 Without support<br /> 
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 I am alone<br /><br /> 

  

 Without dreams<br /> 

 Without a course<br /> 

 Without desire<br /> 

 I will not succeed<br /><br /> 

  

 So I look to life<br /> 

 And believe in me <br /> 

 And know that I am truly who I want to be<br /><br /> 

  

 A girl of today<br /> 

 Preparing for tomorrow<br /> 

 But never forgetting who I am 

  

 </blockquote>  

  

</div> 

 

</body> 

</html> 
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HTML Markup Meaning  

1. <title>  

 

2. <! … -->  

 

3. <body>  

 

4. <h1>  

 

5. <div>  

 

6. <h2>  

 

7. <p>  

 

8. <em>  

 

9. <img 
src="apples.jpg"> 

 

 

10. <blockquote>  
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 Student Resource 4.2 

Anticipation Guide: HTML Tags 

Student Name:_______________________________________________ Date:___________ 

Directions: For each of the HTML tags below, write how you think the tag affects the text on a web page 
in the “My guess” row. Give your reason in the “My reason” row. As you learn more about HTML code 
during this lesson, write what you learn in the “I learned” row.  

 <img src="image.jpg"> 

My guess:  

My reason:  

I learned: 
 
 

 <head> 

My guess:  

My reason:  

I learned: 
 
 

 <ul> 

My guess:  

My reason:  

I learned:  

 <body> 

My guess:  

My reason:  

I learned: 
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  Student Resource 4.3 

Reading: How HTML Works  

What Is It? 
HTML stands for Hypertext Markup Language, and it is the standard language that web designers use to 
make web pages. When a browser opens a page in HTML, it displays all the parts of the page—its text, 
its images, and its links—even though the HTML page has text only.  

Why Do We Use HTML? 
We use HTML so that web browsers can understand how to read web pages. HTML describes the 
structure of a web page by standardizing the elements contained on that page. Because it has become 
an international standard, HTML is used as the primary language on the World Wide Web. All web 
browsers can load a page written in HTML. Because HTML can be interpreted by any browser, a page 
written in HTML will work the same for all its users.  

How Does HTML Work? 
Web developers “mark up” the elements of a web page by using angle brackets (< >). The angle brackets 
and the information inside them, called tags, are not shown on the web page. Instead, the tags give 
structure to the content of the page. For example, a <p> tag sets off a paragraph, and an <h1> tag 
indicates a heading that will be big and bold. When web designers refer to markup, they mean both the 
content of the page and its tags. Web designers say that tags are “hidden.” Tags are predefined words or 
acronyms and should always be written in lowercase letters.  

Most HTML tags work in pairs that surround the content of the web page. For instance, in the sample web 
page in Student Resource 4.1, you can see the tag <p> at the beginning of the first paragraph about 
Marina. At the end of the paragraph, you can see this end tag: </p>. Start and end tags, which are also 
called opening and closing brackets, tell the browser how to display the information in between them. End 
tags are the same as the start tags, except that they have a slash after the first angle bracket. They “turn 
off” the instruction given by the start tag.  

Look at the source code of any website by selecting View > Source (in Internet Explorer), and you will see 
many different start and end tags. It is always good to have a list handy of all the tags you need to build a 
web page. Ask your teacher for one, or look at http://www.webmonkey.com/2010/02/html_cheatsheet/ or 
http://www.tolweb.org/tree/learn/TreebuilderTools/AlltheHTML.html for a thorough list of HTML tags.  

Think of HTML tags as being on a string. When the browser sees a start tag on the string, it will follow that 
command until it gets to the same end tag. Because of the way HTML is read by the browser, you can 
embed (or nest, as designers say) tags within other tags. For instance, all tags are embedded between 
the <html> and </html> tags. They are the first and last tags of all HTML documents since everything 
in between them is in HTML. 

Basic Document Structure 
All web pages written in HTML must follow a standard format. The basic sections of a web page are 
called elements; a standard page has three elements: the line that contains the HTML version 
information, the head section, and the body. 

To show that it is written in HTML, a document begins with the start tag <html>. This tag is called the 
root element of the page.  
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The head element comes next in the HTML document. It is designated by the <head> tag and contains 
general information about the web page, such as its title and style. The elements inside the head element 
usually are not displayed by the browser. According to the HTML standard, the only tags that should go 
inside the head section are: <title>, <link>, <base>, <script>, and <meta>. 

 The <title> information is what will show up in the title bar of the browser window. This 
information will also be displayed as the name of the page in a user’s bookmarks or favorites list.  

 The <link> tag is used to define the relationship between a document and an external resource 
for the web page. Most often, the link tag references a cascading style sheet, which determines 
how the page looks when it is presented. 

 The <base> tag defines the base location for the links on the page.  

 The <script> tag links to external script sources (usually JavaScript), or surrounds non-HTML 
code that adds functionality to the page. 

 The <meta> tag defines the meta elements, which specify page description, keywords, and any 
other information not provided through the other head elements and attributes.  

The rest of the page will be in the body element. The <body> tag defines the section that contains all the 
text, images, and links that will show up on the page.  

The following example shows the most simple of web pages. 

<html> 

<head>  

<title>Simple Web Page</title> 

</head> 

<body>This is my first page.</body> 

</html> 

If it is possible, open a text editor and copy this simple page’s HTML exactly. Save it as an HTML 
document (*.html) and reopen it in a web browser. You will see that the only text visible on this page is 
the title, “Simple Web Page,” and the body, “This is my first page.” All the other tags are invisible but will 
tell any browser to display this text as a web page.  

HTML also allows web designers to put comments into the source code. These comments are invisible on 
the actual web page but give useful information to those looking at the code. In the sample web page in 
Student Resource 4.1, you can see comments in the source code. Comments are for two audiences: the 
original page author, who may wish to leave content reminders (“Find picture of dog.”), and future code 
maintainers, who may wonder why something was done in a particular way on a complex page (“This 
next section checks the availability of the weather RSS feed and displays it.”). Note that the future coder 
may be the original author who has forgotten why something was coded in a particular way long ago. 
Comment tags can also be very helpful in organizing web pages that contain an extensive amount of 
code. A comment tag is a combination of an exclamation point and two hyphens (a dash). It closes 
differently from other tags, using two hyphens and then a closing bracket. Here is an example: <!--This 
is a comment-->. Examples of common comment tags include <!--NAVIGATION BAR-->, <!--
MAIN TEXT-->, and <!--FOOTER-->. By adding comment tags throughout the code, you make it 
easier to identify sections of your code as you scroll through. This not only helps you, but is useful for any 
other future code maintenance.  

Of course, good web pages have many more elements than this example. It does not take long to learn 
the basics of HTML and begin creating your own pages. As long as all pages have the basic tags 
<html>, <head>, and <body>, they can be enhanced in many ways, by changing the look of the text, 
creating separate spaces such as paragraphs, making lists, and adding graphic elements.  
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Empty Elements 
Some elements in HTML are called empty elements because they do not have text content. The <img> 
element (image element) is empty because it commands the browser to go to the server to get a graphics 
file instead of displaying the image in the code. Because images require communication with the server, 
they use special instructions called attributes, which give needed information about an element. Image 
elements need to have a source attribute (src), which indicates the URL or file name of the image. Image 
elements also can have an alt attribute, which gives a textual description of the image in case the image 
itself does not show up on the page. The alt attribute also helps people with disabilities use the web and 
are important for that purpose.  

This is sample HTML code for an image that shows a picture of a dog. The picture is in JPEG format. This 
code contains the two attributes of images, src and alt. (There are never spaces between an attribute, 
the equal sign, and the quotes containing the attribute.) 

<img src="dog.jpg" alt="photo of dog" /> 

Style Sheets 
You can use the <link> tag to reference style sheets to specify (for example) the background color of a 
web page, the color of an active hyperlink, and the color that the link turns after you click it. These content 
styling attributes can be defined in the tags placed directly around the content to be styled. However, as 
web pages become more complex, web designers find that they need a better way to describe what the 
page should look like. Using external (linked) style sheets makes it easy to specify the way the page is 
presented. Using an external cascading style sheet (CSS) is industry best practice.  For example, in a 
style sheet, you can detail the amount of white space between text lines, the amount of indentation of 
each line, and the font size and typeface. The use of style sheets separates the content of the web page 
from its presentation so that you can change the presentation without revising the source HTML 
document. HTML describes what the content is, such as a paragraph of text (<p>), and a style sheet 
describes what a paragraph looks like on that web page—everything from font to the amount of space 
between paragraphs. Having a separate style sheet file also makes it possible to create multiple web 
pages that have a similar look and all use the same style sheet. 
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Student Resource 4.4 

Reference: Most Important HTML Tags 

These tags are the most commonly used in HTML coding. Make sure to code them carefully so that your 
web page looks how you want it to! 

Structural Tags 

<html> HTML document—required in all HTML documents. 

<body> Body element—required in all HTML documents. 

<head> Head of the page—required in all HTML documents.  

<meta> Gives additional page information to the browser—invisible.  

<title> Document title. 

Container Tags 

<div> Encapsulates other page elements and divides the HTML document into sections. 
Web developers use this to group paragraphs and then, using a CSS style sheet, 
apply a style to the <div> tag instead of coding the same style for each 
paragraph element. 

Heading and Text Tags 

<blockquote> Long quotation—indents from both sides. 

<br /> Inserts single line break—an empty element. This tag requires a slash in XHTML 
because there is no closing tag; in HTML5, the trailing slash is not required. 

<h1> to <h6> Font size of header, <h1> (largest) to <h6> (smallest). 

<hr /> Inserts a horizontal line—an empty element. 

<em>  Emphasizes a word, typically by making it appear in italics. 

<p> Paragraph—to insert more space between two paragraphs, use two tags. 
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Heading and Text Tags (continued) 

<q> Quotation—puts text inside quotation marks. 

<strong> Emphasizes a word, typically by making it appear in boldface. 

Graphic Elements 

<img /> Image—include the source (src) attribute with all img tags.  

Links 

<a href="URL"> Creates a hyperlink. 

Lists 

<li> List item. Must be nested inside <ul> </ul> tags for an unordered list or <ol> 
</ol> tags for an ordered list. 

<ol> Ordered list—indicates the beginning and end of a list with list items (li) 
numbered. 

<ul> Unordered list—indicates the beginning and end of a list with list items (li) 
bulleted. 
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Student Resource 4.5 

Reference: Most Common HTML Mistakes 

These are the most common problems web designers encounter when coding their pages. If you are 
having problems coding your page, look for these mistakes: 

1. Forgetting the slash in the closing tag: Without the slash, the browser does not know to turn off 
the tag.  

Incorrect: <h3>Mistakes I've Made<h3>    

Correct: <h3>Mistakes I've Made</h3> 

2. Leaving out an angle bracket: Browsers will ignore unknown tags; any missing elements are 
interpreted as unknown tags. 

Incorrect: <emMistakes I've Made</em>   

Correct: <em>Mistakes I've Made</em> 

3. Leaving out quotation marks in tags with attributes: Quotation marks must surround the value 
of an attribute, such as the file name of an image source. 

Incorrect: <img src="dogsplayingpoker.jpg> 

Correct: <img src="dogsplayingpoker.jpg"> 

4. Not “escaping” character symbols when you want them to appear as text on the page: 
Because symbols such as <, >, &, and " are used in HTML, they must always be specially coded 
(“escaped”) if you want them to appear on your web page. 

Incorrect: <div id="character"> (assuming you want this code to display on your web page) 

Correct: &lt;div id=&quot;character&quot;&gt; 

5. Incorrectly inserting special characters: To have a symbol such as © appear on your web 
page, or a “curly” quotation mark like you would see in a Word document, you must code those 
characters if you want them to appear correctly. 

6. Nesting elements incorrectly: Nested tags must be closed in the reverse order they were 
opened.  

Incorrect: <p><strong>My bold text</p></strong> 

Correct: <p><strong>My bold text</strong></p> 

 



AOIT Web Design  
Lesson 4 The Role of HTML 

Copyright © 2008–2015 National Academy Foundation. All rights reserved. 

Student Resource 4.6 

Guide: Sample Web Page Modification 

Student Name:_______________________________________________ Date:___________ 

Directions: Your teacher will give you access to Marina’s sample web page. Follow the steps below to 
improve the look of the page. 

Step One 
Look carefully at Marina’s sample web page. Decide on two changes you would like to make to the page 
to make it look better to you. Sketch a new version of the web page that shows it with the changes made.  

Step Two 
Look through your resources to find the tags you need to make the changes you want. Write the structure 
of your new HTML code here:   

 

 

 

 

Note: If you cannot find the tags you need to make the changes you want to make, choose different 
changes that use tags that you can find.  

Step Three 
Open the sample web page in a text editor such as Notepad. Make your changes to the HTML code. 
Once you have changed the code, rename the file to show that it is yours. Best practice is to choose a file 
name that does not contain spaces, because web browsers cannot read the spaces correctly. So instead 
of naming your file “my web page.html,” you may want to name the file “mywebpage.html” instead, so that 
the file will open up in your browser. 

Now open the file in a web browser. Compare your web page to your sketch. If they match, you are 
finished. If not, revise your HTML code and repeat Step Three.  

If necessary, ask for help from your classmates or teacher, or offer your help to any classmates you can! 
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Student Resource 4.7 

Minor Project Work: Your Personal Web Page 

Directions: For your minor project, you will use HTML coding to create a web page about yourself. This 
web page will be posted on your class’s website, so you want to do your best work. Follow your teacher’s 
instructions to complete each of the steps of the minor project that are described below. Review the rubric 
that your teacher gives you so that you understand how your work will be assessed before you begin 
working. 

Planning 
Your web page should include the following sections. Plan the content for each section before you begin 
your sketch. 

 An “About Me” section: This section of your web page will give a brief description of you. Be sure 
to include where you attend school, when you will graduate, why you are in AOIT, your internship 
or work experience (if you have it), and your interests outside of school. Remember to keep this 
section short. This section should be written in paragraph form.   

 Photograph #1: This picture should be you alone. It can be a school photograph, a picture of you 
doing something you are interested in, or a picture of you at work or your internship. Include a 
caption (a short explanation below the photograph). 

 Photograph #2: This picture can include other people if you wish. Include a caption.  

 A list: This list can be ordered (with numbers) or unordered (with bullets). The example web page 
includes a list of the student’s favorite video games. 

 Links to your two favorite websites: Choose two websites that you like, and provide links to them 
so that those who visit your web page can click to visit your favorite sites. 

 An “Individual Choice” section: You can include a poem, something you’ve written or created for 
AOIT or another class, or something else that reflects well on you. Remember who your audience 
is for this web page: potential internship providers, employers, or colleges, so think carefully about 
what to include.  

Sketching 
Sketch out a sample of your web page that shows what it should look like. In the margin of the sketch, 
write down the tags that you plan to use for each line. Keep in mind that you need to be able to create 
your web page with the HTML tags that you have learned, so you should be able to write tags for 
everything on your page. See the sample sketch in Student Resource 4.8, Example: Web Page Sketch, 
to get an idea of what your sketch should look like.  

Coding 
When your sketch is complete, use a text editor to write your HTML code. Save your file as an HTML file 
(*.html) and check it in your browser as you work. Remember to begin with the header information and 
then create the body part of your page. Remember to include comments in your code that explain what 
you are doing. Check your page often in a web browser as you are working to make sure things look as 
you expect. 
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Testing and Troubleshooting 
Look at your web page in a browser and note any items that do not look as they should, and then review 
the code in your text editor and try to find the problem. Use Student Resource 4.5, Reference: Most 
Common HTML Mistakes, to help you spot your mistakes. 
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Student Resource 4.8 

Example: Web Page Sketch 

Directions: Use this example to help you sketch your web page. 
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Student Resource 4.9 

Feedback Sheet: Peer Web Page 

Directions: You will be looking at five of your classmates’ web pages and giving them each constructive 
feedback about their web pages. Choose the five web pages according to your teacher’s instructions, and 
fill out the sections below. (Make a separate page with the prompts below for each web page you review.) 
Keep in mind that everyone will be making a change to their web pages based on this feedback, so be as 
specific as possible. 

 

Your name: 

Web page author: 

What I like best: 

 

 

 

What I want to know more about: 

 

 

 

One change you may consider making is: 
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Student Resource 5.1 

Reading: Website Development Tools  

 

This presentation gives an overview of the web development tools most commonly used by web 
designers today. It is in no way complete, as there are many tools available beyond these, most of which 
are specialized and require specific skills beyond the scope of this course.  

While viewing this presentation, think about the websites you visit and how they integrate these tools.   
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With a text editor, you can write HTML code to create pages that are the building blocks of web design. 
These editors allow you to edit both HTML and XHTML as well as CSS and JavaScript and other 
common coding languages. WordPad and Notepad are popular text editors that come preinstalled with 
the Windows operating system. TextEdit is a text editor that comes preinstalled with the Macintosh 
operating system. Notepad++ is a free text editor especially designed for programming. You can 
download Notepad++ from notepad-plus-plus.org. When you use these editors for HTML code, you have 
to save the file with the file extension .html or .htm, not .txt. 

WYSIWYG (which stands for “What You See Is What You Get”) editors allow you to create or modify web 
pages without writing the HTML code. Instead, you write what you want to see on the page, and the editor 
translates it into HTML code. Dreamweaver, Nvu (pronounced N-view), Office SharePoint, and iWeb are 
popular WYSIWYG editors. A popular WYSIWYG editor for the Mac OS is SeaMonkey.  

Web-based publishing tools allow you to create web pages through a website. WordPress, Blogger, and 
Medium are popular web editors. 
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When you use a text editor, you type both the content and the HTML tags that define the content as 
headings and paragraphs and such. When you are finished coding the page, you save the file with the file 
extension .htm or .html.  

Most experienced web designers prefer to code directly in a text editor because it gives them more 
control and flexibility. They prefer to have control over what the web page looks like and how to organize 
the underlying code. 



AOIT Web Design  
Lesson 5 Tools for Website Development 

Copyright © 2008–2015 National Academy Foundation. All rights reserved. 

 

WYSIWYG stands for “What You See Is What You Get.” So what you type on the page is actually what 
you will see when your web page is posted. You don’t have to manually enter any of the HTML tags or 
other coding. A WYSIWYG editor has toolbars and menus to make it easy for you to format your text. The 
final web pages should be very similar to what is displayed in the editor prior to publishing. Some 
WYSIWYG editors insert all kinds of extra information and create code that is pretty messy. To see an 
example of this, save a Microsoft Word document as a web page (.html), and then look at the source 
code. You will see many lines that are really not necessary for the web page, and a web designer would 
not consider this code to be clean. 

Some WYSIWYG editors, such as Dreamweaver, let you see both the web page and the HTML code. 
This allows you to create clean code as you go. 

Often a web page created with a WYSIWYG editor will not look exactly as you expected when it is 
published, and you will have to take additional measures such as modifying the HTML or the CSS directly 
in the code.  

As you get more experience creating web pages, you may find that it is usually faster to code the page 
manually than to use a WYSIWYG editor. Additionally, the code you write yourself is oftentimes “cleaner” 
than the code that the WYSIWYG tool creates. Finally, if you always use a WYSIWYG editor and don’t 
learn to code HTML, you will likely be classified as a perpetual amateur and be trapped in the confines of 
what the WYSIWYG software allows you—which can become limiting. 
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Web-based publishing tools have a user-friendly interface based on Ajax. Ajax allows JavaScript to 
manage other technologies that dynamically change a web page when users interact with a feature. An 
example is Google’s Suggest feature, which displays suggested search terms from a database based on 
the visitor’s input into the search field. Without Ajax, the database could not be searched without 
reloading the entire page. 

Web-based publishing tools allow users to go to a website where they can post pages directly. These 
tools are often used for social networking and blogging. Examples are Facebook, Xanga, Blogger, and 
WordPress. 

One of the great advantages of a web-based publishing tool is its Content Management System (CMS). A 
CMS is a content and file management tool that makes it easy to publish, edit, and organize content, as 
well as collaborate with others on content. It also eliminates the need for FTP transfers. Nearly all 
commercial websites run their own CMS, because maintaining a large website is daunting without one. 

Web-based publishing tools generally don’t require knowledge of HTML. They have built-in templates and 
visual themes. Often there are additional templates that you can browse and install, though these may 
need to be purchased. They also may have add-on features, like adding a Twitter feed to your pages.  

Some web-based publishing tools offer the ability to modify HTML, for more advanced users.  
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This slide lists some of the basic web design components; each allows designers to add specific functions 
to their pages. The basics of each are explained in this presentation. 
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HTML, or Hypertext Markup Language, describes the structure of the content on a web page by “marking 
up” text. It identifies certain text as links, headings, paragraphs, lists, and so on, and supplements the text 
with images, forms, and other objects. HTML is written in the form of tags, which are surrounded by angle 
brackets. HTML pages use special tags to embed graphics and animation in web pages. 



AOIT Web Design  
Lesson 5 Tools for Website Development 

Copyright © 2008–2015 National Academy Foundation. All rights reserved. 

 

When designers create web pages, there are two main issues they must address: document content and 
document presentation.  

Document content is written in HTML and includes all the text on the page. HTML also includes links to 
other pages, images, or multimedia and the formatting of the pages.  

Although you can use HTML to control the document presentation, or how the page looks, it is nearly 
impossible to code web pages using HTML without CSS unless the pages are extremely basic. HTML 
and CSS function as a pair. 

CSS allows you to establish style rules that dictate how the document will look. If you want several pages 
to have all or some of the same colors, layout, and text formatting, you can put your styles into a separate 
text document with the file extension .css. You can then reference the style sheet in your HTML 
documents with a simple link in the head. This saves a lot of time in developing websites, because you 
don’t have to redo the work of coding this information for each web page of the site. For example, if a 
client wants to change the color of the header font, you can make the change once in the CSS file, and 
the header font will be updated automatically on each HTML web page. 
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Graphics source files are referenced in the HTML file using an <img /> tag.  

Use the PNG (.png) file format for images that have sharp contrast, like line drawings or other textual or 
icon graphics. But PNG images cannot be animated, so the GIF (.gif) file format is typically used for 
animated images. Use either PNG or GIF file format for cutout images that will need a transparent 
background. Use the JPEG (.jpg) format for photos or images that have realistic looking scenes and/or 
smooth variations of tone and color.  

You may use an image editor like Adobe Photoshop to alter images. Alterations include cropping, 
rotating, changing colors, and adding artistic effects. You may use a drawing tool like Adobe Illustrator, 
Microsoft Visio, or Bohemian Coding Sketch (http://bohemiancoding.com/sketch) to create drawings, 
flowcharts, and shapes for your website, although you will typically need to “rasterize” the end product to 
create a JPEG or PNG file for use on the web. 

Navigational elements like buttons, tabs, button bars, and menus can be created with graphics or directly 
with CSS, depending on the desired effect. Images can be managed using CSS rules for placement, 
color, and even interactive color and position effects. More elaborate effects can be built using the 
JavaScript programming language. 
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Animation is often a series of frames that give the impression of moving footage. WYSIWYG editors 
include features to create your own animation. Flash animation is one method used to provide video and 
animated websites to users. The Flash graphical user interface (GUI) makes it easy for the novice 
website builder to create fluid, animated websites without having to write any code. However, since Flash 
animations often require a separate web browser plug-in and are not presented to users of Apple mobile 
devices, it is important for web developers to consider whether Flash is the right choice. JavaScript and 
CSS combined offer another way to create animated page effects, and video can now be streamed to all 
recent browsers. Since the advent of HTML5, the options for animating objects within a web page have 
become much more robust and effective. 
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The Flash browser plug-in allows designers to deliver a variety of multimedia file types to website visitors. 
The HTML code of the web page where the multimedia file will be displayed must reference the 
multimedia object in one of two ways: 

• If you are writing HTML code with a text editor, you use the <object> tag to specify the source file 
and set its dimensions, parameters, and other attributes. 

• If you are using a WYSIWYG editor, you specify the multimedia files that you want to embed in 
the web page using a GUI editor, as shown on the slide. In both cases, the actual HTML code will 
contain the <object> tag instructing the browser to load the multimedia file. 

Video clips are popular multimedia objects to insert into web pages. They can be referenced within HTML 
files using either an <object> tag or a <video> tag.  
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Scripting languages allow web designers to create dynamic web pages. Some simple examples of 
JavaScript usage are: 

1. Controlling the size, position, and look of a new window or pop-up. 

2. Validating web form input values to make sure that they will be accepted before they are 
submitted to the server. 

3. Changing page elements such as images, menus, and text based on user input. For example, 
you can use JavaScript to show and hide elements on a page based on user input. Or the 
JavaScript could show a new photo when the user clicks Next in an image gallery, and smoothly 
animate the change of the images. 
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Server-side scripts allow the page to be generated differently for each user. The response of the page is 
customized based on the user’s requirements, access rights, or queries into the data stores. The most 
commonly used server-side scripting technologies are .NET with SQL, and PHP with SQL.  
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These elements work together to make web pages interesting, dynamic, and polished. As you gain 
experience using each of them in web design, your pages will look more professional.  
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Student Resource 5.2 

Taxonomy: Website Development  

Student Name:       Date:    

Directions: Write the terms you know about website development tools and technologies next to the letter 
they begin with.  

A  

B  

C  

D  

E  

F  

G  

H  

I  

J  

K  

L  

M  

N  

O  

P  

Q  

R  

S  

T  

U  

V  

W  

X  

Y  

Z  
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Student Resource 5.3 

Research: Website Development Tools 

Directions: Working with your group, research the web development tool that your teacher assigns to you. 
Use the websites listed below to begin your research. (You may also want to look at other websites.) 
Write notes about your tool on chart paper, using the headings listed below. After you complete your 
research, hang your chart paper on the wall to teach the rest of the class about your tool. 

List these headings on your chart paper: 

 Name of Tool 

 How Designers Use It 

 How Website Visitors Benefit from the Use of This Technology 

 Example of a Website That Uses the Tool  
(Since you can’t always tell what technologies a website is using, you may need to make an 
educated guess with supporting arguments.) 

 Advantages and Disadvantages of This Tool 

 Miscellaneous Information That Is Important to Know 
 

Website development tool resources: 

CSS 

 CSS Introduction: http://www.w3schools.com/css/css_intro.asp  

Graphics 

 GIF: http://en.wikipedia.org/wiki/Graphics_Interchange_Format  

 JPEG: http://en.wikipedia.org/wiki/JPEG  

 Adobe: http://www.adobe.com/ 

Animation 

 Animation Learning Guide for Flash: 
http://www.adobe.com/devnet/flash/learning_guide/animation.html   

 Graphic Effects Learning Guide for Flash: 
http://www.adobe.com/devnet/flash/learning_guide/graphic_effects.html 

 Flash Animation: http://en.wikipedia.org/wiki/Flash_animation 

 Flash vs. JavaScript: http://logicpool.com/archives/30  

Multimedia 

 HTML Multimedia: http://www.w3schools.com/html/html_media.asp  

 Video Learning Guide for Flash: http://www.adobe.com/devnet/flash/learning_guide/video.html 

 HTML5 Video: http://www.w3schools.com/html/html_videos.asp  

 Microsoft Silverlight: http://en.wikipedia.org/wiki/Microsoft_Silverlight  

 How Streaming Video and Audio Work:  
http://electronics.howstuffworks.com/streaming-video-and-audio3.htm 
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JavaScript 

 Thau’s JavaScript Tutorial: http://www.webmonkey.com/2010/02/javascript_tutorial/  

 JavaScript Tutorial: http://www.w3schools.com/js/default.asp 

 JavaScript Tutorials: http://www.javascriptkit.com/javatutors/     

 jQuery: http://jquery.com (jQuery is a very popular open source JavaScript library that web 
developers can use to load simplified JavaScript code into their pages. This can vastly simplify 
what otherwise would be a complex task. In addition, jQuery also takes care of cross-browser 
compatibility issues. ) 
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Student Resource 5.4 

Tutorial Part 1: Getting Started with Dreamweaver 

Directions: This tutorial will guide you through the first step in creating a website that you will be adding to 
over the next several lessons. Follow the instructions in this tutorial to set up a directory structure for your 
website, learn how to navigate in the Dreamweaver interface, revise your About Me web page, and then 
create additional web pages on the site.  

Step 1: Setting Up the Directory Structure  
On your local network or flash drive, in the location specified by your teacher, set up a directory structure 
exactly as shown in the following diagram. 

 

As you create new pages, save the web pages for your site in the web_pages folder, and the images in 
the images folder. When you create your home page (index.html) later in this lesson, you will save it in 
your SampleSite_Prototype folder.  

Note: Web developers use underscores instead of spaces in file names, because web servers that run on 
Linux and Unix operating systems do not recognize file names with spaces in them. Also, capitalization in 
file names matters. “Dog.html” is a completely different file from “dog.html.” Some web servers may 
ignore the difference, but you may find that your site no longer works if you upload it to a server that is 
running Apache or other web server software based on the Linux OS. 

Step 2: Touring Dreamweaver  

1. Open Dreamweaver. 

In the upper left corner, in the light gray menu bar, find the DW icon. That’s short for 
Dreamweaver, and that’s how we will refer to Dreamweaver when we’re talking about what you 
see on the screen. Your DW workspace, where you create and edit web pages, should look 
something like the following screenshot. 
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2. Using the File > Open command sequence, open the About Me page you created in Lesson 4. 

 

Your DW workspace should now look something like the following. Notice that the file name (in 
this sample, about_me.html) and the page title (About Me) both appear in the workspace window. 

 

3.  Be sure the workspace layout has been set to Designer, as shown in the following screenshot. 
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There are other possible workspace layouts, as shown in the following image. At some point, you 
will want to explore them, but for now, always be sure your workspace is set to Designer. 

  

4. Tour the three possible “views” in Dreamweaver: Design, Code, and Split. 

The sample About Me web page on the previous page is shown in the Design view (not to be 
confused with the Designer workspace layout). In Design view, the web page looks a lot like it 
does in a web browser. 

  

 

Most of your initial web creation and editing will be done in Code view. The following screenshot 
shows the sample About Me page in Code view. 
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You can also split the screen to see both the code and the web page design at the same time. The 
following screenshot shows the sample About Me page in the Code view on the left and the 
Design view on the right. With the Split view, you can immediately see changes made in one view 
reflected in the other.  

 

5. Try out each of these views with your About Me page. 

6. For now, set the view to Code. 

7. Check the bottom of the workspace to be sure the Properties window is set to HTML. 

 

8. As you can see on the right side of the workspace window, there are a number of panels included 
in Dreamweaver. For now, don’t change or move any of them. 

 

9. In the Files panel, navigate to the directory structure you created in Step 1. 
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Step 3: Create a New Web Page in Dreamweaver 
The About Me page you created in Lesson 4 provided a general introduction to the person you are, and 
included some information about your school activities, family, pets, personal taste, and activities.  

In this part of the tutorial, you will create a new About Me page that is similar to the old one but focuses 
more on you as a student, hopeful intern, and future employee. You will call this new page 
about_me_professional.html. 

You created your first About Me page in a text editor. This time you will use Dreamweaver. Doing so will 
teach you the fundamentals of editing using DW and will also enable you to compare editing in a text 
editor with editing in Dreamweaver. 

1. Be sure your original About Me page (about_me.html) is still open in Dreamweaver. 

2. Use the command sequence File > New to create a new file. Be sure the selected file properties 
(which are the default properties in DW) are the same ones shown in the following screenshot. 

 

3. Notice that both the About Me page and the new (untitled) page are accessible in the workspace. 
Also notice that some of the structural HTML code that you had to type in by hand in the text editor 
is already provided in the new DW file. 
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4. Title your new page About Me Professional. Notice that the title displayed in the code changes 
from “Untitled Document” to “About Me Professional.” 

 

5. Look back at your original About Me page. (You might want to display it in Design view so that you 
can read the text more easily.) Decide which parts of your original page you might want to use in 
the new About Me Professional page.  

Your “professional” information should include text that focuses on your skills and experience that 
would be of interest to a person considering you for an internship or a job. The images below 
show text selected from the sample About Me page that would make a suitable first draft for About 
Me Professional. 

  

You might or might not want to include a list of your hobbies or interests. The more closely they 
are related to your professional ambitions, the more suitable they are for a professional About Me 
page. 

 

6. Now check to be sure both your original About Me page and your new About Me Professional 
page are being displayed in Code view. 

7. Select the text from About Me that you want to add to About Me Professional, one paragraph at a 
time. Copy each paragraph to the new file. Be sure you add the paragraphs in the <body> section 
of the new page. 

8. Do not include any images in the new file. 

9. In either Design or Code view (whichever is more comfortable for you), edit the text until you 
believe it serves its purpose as a professional introduction to you.  
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If you want to present a casual image, keep the text in the first person (for example, “Next 
semester I hope to take Python programming.”). If you want to make your professional description 
more formal, use the third person (for example, “Next semester Dan hopes to take Python 
programming.”). 

Whichever tone you decide to adopt, be sure you are consistent: use either the first person or the 
third person throughout the new page. 

The text on your page should look something like this example: 

 

10. Save your new About Me Professional page in the web_pages directory as 
about_me_professional.html. 

11. Open a browser and navigate to the page you have just created. 

 

12. Check to be sure your page looks correct in the browser environment. 

13. If you make any changes, save the file again. Notice that you have to save your file and refresh 
your browser to see the latest version of the file. 

  



AOIT Web Design  
Lesson 5 Tools for Website Development 

Copyright © 2008–2015 National Academy Foundation. All rights reserved. 

Part 4: Create Another Web Page in Dreamweaver 
In this activity, you will create a page where you can collect tips and techniques that are helpful to you 
when you are working with Dreamweaver. 

1. Create a new file with the title Dreamweaver Tips and Techniques. Save the file in the web_pages 
directory as tips_ techniques.html. 

2. Create two H1-level headings in your new file: “Helpful Hints” and “How To.” 

3. Under the Helpful Hints heading, create an unordered list using the <ul> and <li> tags and 
include at least two things you have learned so far in this activity. (Example: “Dreamweaver 
automatically includes the structural tags you need for a new web page.”) 

4. Under the How To heading, include the steps required to do a simple task in Dreamweaver, such 
as opening an existing page. Create a new H2-level heading (for example, “Open an Existing Web 
Page”). Then create an ordered list using the <ol> and <li> tags. Make each step in the task 
(such as “1. Go to File > Open”) a separate list item.  

5. Resave your file. 

6. Check your new web page in Design view and also in your browser. 

7. If you make any additions or changes to your file, save it again. Always remember to save your 
files often! 

Your Sample Site So Far 
The web_pages directory in your Sample Site Prototype should now have the following files: 

 about_me.html 

 about_me_professional.html 

 tips_techniques.html 
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Student Resource 5.5 

Tutorial Part 2: Creating and Modifying Web Pages 

Directions: Follow the steps below to combine the information on your About Me Professional web page 
with information from a partner to create an About Us page. (You and your partner will each create your 
own About Us web page, but your pages will look very similar.) Then continue following the steps to 
modify your own Tips and Techniques page.  

Step 1: Create an About Us Page 
Your About Us page will have three H1-level sections. The first section will tell about both you and your 
partner, the next section will tell about you, and the third section will tell about your partner. Follow these 
instructions to create your page: 

1. Open your about_me_professional.html page if it is not already open. 

2. Create a new page with the title About Us, and save the new page as about_us.html. 

3. In the body of your new page, create an H1-level section called About Our Team.  

Under this heading, add text that defines your team (that is, you and your partner) and that names 
your team members (for example, “Our Dreamweaver team consists of two people, Dan and 
Marina.”) Take time to discuss with your partner which voice is most appropriate for the About Us 
page—first person (“I”) or third person (“Dan”)—because the text about you and your partner must 
be consistent. 

4. Create another H1-level section in the body of your new page, this one called About Yourname. 

Copy the paragraphs from your About Me Professional page and paste them under this heading 
on your new About Us page. 

Save your About Us file. 

5. Create a final H1-level section of your new page and call it About Yourpartnersname. 

Copy the paragraphs from your partner’s About Me Professional page and paste them under this 
heading on your new About Us page. 

Working with your partner, look again at the draft text you copied over from your About Me 
Professional pages. Decide whether anything needs to be changed to make your About Us page 
more effective. Make whatever changes you and your partner decide on. 

Review your completed changes with your partner and make adjustments, if necessary. 

6. With your partner, test your About Us page in Design view and in your browser. Make adjustments 
if necessary. 

7. Resave your About Us file. 
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Step 2: Modify Your Tips and Techniques Page 

1. Open your Tips and Techniques page if it is not already open.  

2. Think of at least one more helpful hint or how-to procedure you have learned so far in 
Dreamweaver, and add the new helpful hint or how-to to your Tips and Techniques page. 

3. Save the Tips and Techniques page. 

4. Test the page in Design view and your browser. 

5. Resave the Tips and Techniques page. 

Your Sample Site So Far 
The web_pages directory in your Sample Site Prototype should now have the following web pages: 

 about_me.html 

 about_me_professional.html 

 about_us.html 

 tips_techniques.html 
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Student Resource 5.6 

Tutorial Part 3: Creating a Website with a Home Page 

Directions: In this tutorial, you will create a home page for your Sample Site and link your pages to it. You 
will also create a web page with helpful links on it and link that page to your home page. 

Step 1: Create a Home Page for Your Sample Site 

1. Open Dreamweaver and create a new page with the title Sample Site Home Page and with the 
H1-level heading and text shown in the following image. 

 

2. Save the file as index.html in the SampleSite_Prototype directory. 

Be sure you save it in SampleSite_Prototype and not in the web_pages directory. 
SampleSite_Prototype is called the root directory, and it is traditional to put the home page there. 

3. Check your new home page in Design view. 

4. Open a browser and check the home page in the browser. 

Step 2: Link Your New Home Page to Your Other Web Pages 

1. Switch your new home page to Code view.  

2. Create a new paragraph after the existing text on your home page, and inside the paragraph 
create a link to your About Me page. 

You have created links before. In the About Me page you created in Lesson 4, you put in links to 
your favorite web pages. Those links specify a complete URL (Uniform Resource Locator, or 
external website address) and are called external links. For example: 

  

This time you will be linking to a local file (such a link is called a local link), so you do not need the 
complete URL. Your link should look like this: 
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Think about why the “web_pages” directory name is in the file path. Remember that the file in 
which you are including the link is in the root directory of your Sample Site, and the file being 
linked to is in the web_pages directory. 

3. Create a second link, constructed the same way as the first, to your About Me Professional page. 

4. Create a third link to your About Us page. 

5. Create a fourth link to your Tips and Techniques page. 

The Code view of your home page should now look something like this (minus the “Useful Links” 
link, which you’ll add in the next step): 

 

6. Look at your home page in Design view to be sure there are no obvious problems. 

7. Open your home page in a browser and test all the links. 

Step 3: Create a Useful Links Page 

1. Create a new web page with the title Useful Links. 

You can use this page to add links to external web pages that might be useful to you in creating 
your own web pages and using Dreamweaver. 

2. Save the Useful Links page as useful_links.html in the web_pages directory. 

3. On the Useful Links page, add a link to the Adobe Dreamweaver help and support page. 
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This will be an external link, so you need to use the full URL, including the http. 

 

It is traditional when linking to an external website to cause a new tab or window to open, so that 
the user of your site doesn’t navigate completely away from the original site when following the 
link. To do that, you need to add the target attribute to your link. Adding target="_blank" will 
cause the link to open on a new page. 

 

4. Add a second external link to the Adobe Dreamweaver product page: 

 

5. Check your Useful Links page in Design view. 

6. Save your Useful Links page. 

7. Check your Useful Links page in a browser. 

8. If you make any changes after checking your page in a browser, save your Useful Links page 
again. 
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Step 4: Link the Useful Links Page to Your Home Page 

1. In your Sample Site Home Page, add a link to your Useful Links page, just as you did with the 
other pages on your site. 

2. Save your home page. 

3. Test your entire website in a browser and fix any problems discovered during the testing process. 

Step 5: Add to Your Useful Links Page, Save, and Test 

1. Working with your partner, go back and look through your notebook for other links to add to your 
Useful Links page.  

2. After you have added two or three more links, save and test your website again. 

3. Close Dreamweaver.  

Your Sample Site So Far 
The web_pages directory in your Sample Site Prototype should now have the following web pages: 

 about_me.html 

 about_me_professional.html 

 about_us.html 

 tips_techniques.html 

 useful_links.html 

In addition, your root directory contains a home page (index.html) that links in all the other pages.  
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AOIT Web Design 

Lesson 6 
Formulating a Website 

Student Resources 

Resource Description  

Student Resource 6.1 Reference: Website Development Cycle 

Student Resource 6.2 Reading: Business Requirements  

Student Resource 6.3 Worksheet: Identifying Business Requirements 

Student Resource 6.4 Sample: Client Intake Form 

Student Resource 6.5 Writing Assignment: Business Requirements 

Student Resource 6.6 Review: Culminating Project Client Intake Form 

Student Resource 6.7 Planning Sheet: The Client Meeting  

Student Resource 6.8 Categorization: Productive Client-Designer Relationship Strategies 

Student Resource 6.9 Tutorial: Creating a Web Page with a Table  

Student Resource 6.10 Email Guidelines: Writing a Follow-Up Email 
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Student Resource 6.1 

Reference: Website Development Cycle  

Student Name:____________________________________________ Date:____________________ 

Directions: Compare the way you grouped tasks into the steps of the web development cycle to the way 
tasks are grouped in the left column of the table below. Underline any tasks that were not on your list. In 
the right column, note any tasks you have that are not on the list in the left column, as well as any 
questions you have about how the tasks are carried out or why they are placed where they are. As you 
work through this lesson, add to your notes, and add anything you learn that answers one of your 
questions. 

Professional Website Development Cycle Notes and Questions 

Analysis  

 Why is the website needed? 

 How will the website improve the organization or 
business you are building it for? 

 Who is the target audience (who will be using 
the site)? 

 What are the user needs? Try to talk to 
someone who will be using the website. 

 Define the function of the website (for example: 
commerce, information, support, or 
communication). 

 Identify already-existing data that can be used 
(recycle). 

 

Design & Specifications 

 Create blueprint/site map to show site 
organization. 

 Use wireframes to show the global navigation 
scheme, general placement of text and media, 
and how people will use/interact with elements 
on the pages; get user or client feedback. 

 Create a content plan (a list of all the types of 
text components on a page; decisions on 
images—creating from scratch vs. 
licensing/buying stock images; navigation). 

 Establish the site’s “look and feel” (decisions on 
basic layout, color, font, and navigational 
treatment). 

 Create a clickable mock-up/prototype and get 
input from client and/or focus groups. 

 Make adjustments in project plan, design plan, 
and prototype as needed. 
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Professional Website Development Cycle Notes and Questions 

Content Writing  

 Secure and/or create final graphic elements. 

 Create text content. 

 Develop media. 

 

Coding/Development 

 Build and format pages. 

 Create navigational system. 

 Make site interactive. 

 Add a site map. 

 Make URLs search-engine friendly. 

 Avoid the use of frames and use Flash and Ajax 
sparingly. If you must use Flash, place the main 
navigation along with text below. 

 Add the alt tag to all your images. 

 

Test 

 Perform “internal” testing (basic quality checks, 
debugging, test on different platforms and 
browsers). 

 Perform “external” or user testing.  

 Upload site to final server and do one final 
round of testing. 

 Check cross-browser compatibility by using 
www.browsershots.org. 

 Make final adjustments. 

 

Promotion 

 Make sure the website reaches the target 
audience by using search engine optimization. 
The title tag and page header are the two most 
important spots to put relevant keywords. 

 
 
 

 

Maintenance 

 Keep watch on site for potential problems. 

 Keep content “fresh” (up-to-date). 

 Since website development is an ongoing cycle, 
determine when the next analysis, update, or 
redesign needs to be done. 

 Keep an eye on your page rank, traffic, and 
trends with tools like Alexa, Google toolbar, and 
Google Analytics. 
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Student Resource 6.2 

Reading: Business Requirements 

Just as you would not travel across country without an idea of where you want to go and how you will get 
there, you would not want to undertake a costly and time-consuming project like designing a website 
without having a clear idea of what you are creating and how you will create it. 

Web designers call the client’s needs for its site the “business requirements.” These requirements tell the 
designer which functions and qualities the website must have to be successful. When a web designer 
clearly understands a client’s business requirements, that designer can determine how the website will do 
what the client needs it to. The more carefully a web designer understands the client’s needs and 
satisfies the client’s business requirements, the more successful the website will be in the client’s eyes. 

There are four categories of business requirements: business, content, functional, and technical. 

Business Category 
The business category defines the business functions that the website will support. These are the 
business processes and other standards and guidelines that need to be considered during the design 
phase. Aspects you need to consider when determining business requirements might include:  

 The process used to create product information for the website  

 The process used to sell products, from start to finish  

 The process used to order products or materials from suppliers  

 Company look and feel standards, such as a company style guide 

 Usability guidelines  

 Expected launch date of the website 

 Any events, announcements, or press releases tied to the launch of the website 

 Any online advertising plans tied to the site  

 Legal and security guidelines/issues 

 The roles of other contributors to or consultants for the website project 

Content Category 
The content category defines all the types of content that will be used on the site. You need to know the 
following types of things about content: 

 What is the purpose of the content? Is it related to any other content?  

 Does the content already exist as web copy or in some other format (e.g., Word, Excel, PDF, 
graphic)?  

 Who owns the content?  

 Who maintains and updates it?   

 Is there a need for legal permission to use the content? 

 Who is the audience for this content?  

 Is there a privacy policy or other legal agreement necessary for the website? 
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Functional Category 
The functional category defines the functions that the website needs in order to meet the business 
requirements. Some functions you might need to develop requirements for include: 

 Personalization: Registration and sign-in, enabling a user to sign up for newsletters, etc. 

 Moderation: Ensuring that discussion boards and comments that appear on the website are 
moderated to exclude harmful messages 

 Social networking tie-ins, such as icons with links to share on Twitter or Facebook  

 Transactions: Shopping cart, reviewing and selecting products  

 Security: Creating a secure registration page, ensuring passwords are secure, ensuring shopping 
cart payment information is secure 

Technical Category 
The technical category includes requirements that ensure that the website can support the number of 
users who visit it and that it functions properly. You need to know the following types of information in 
order to determine technical requirements: 

 Who will host the website and what will the web hosting plan look like? The web host will drive 
many technical decisions on more complex sites and will also affect how well site traffic is 
handled. (A good host will easily absorb traffic spikes without great cost; a cheap host could make 
it irritating to visit the site.)  

 Browser and device support requirements: Is the site supposed to be visible on Internet-enabled 
mobile phones? Which Macintosh and Windows browsers need to be supported? 

 Are there any tools that will be used to measure the success of the website that need to be 
integrated into the website, such as Google Analytics?  

 Security requirements: Is the site a secure site? What are the rules for passwords?  

Defining Requirements Clearly 
The more requirements you can define and document up front, the more likely you’ll be to build the 
website properly. If you don’t clearly define requirements and make sure the site meets them, the website 
may not provide the proper functionality and may fail to support the volume of users who visit it.  

It is best to state business requirements in a list format, starting with what is most important to the client 
and listing all requirements in order of priority. Business requirements should be as specific as possible 
and written using simple, declarative “must” sentences.  

Imagine a T-shirt designer who is working with a web designer to create a website to sell her designs. 
The T-shirt designer’s top priorities are to show her designs and to sell her shirts. Consequently, the first 
business requirements on her list would involve showing and selling the designs and may look like this: 

1. The website must clearly exhibit all 200 of my designs in full color, and the images must not look 
cluttered. 

2. The website must allow customers to safely and securely purchase the T-shirts using credit cards, 
with three clicks or fewer. 

While the T-shirt designer may also need to let people comment on her design ideas, that business 
requirement would be further down on the list of priorities since it is not the client’s main goal for the site. 
Such a requirement may look like this: 
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The website must give visitors the opportunity to comment on T-shirt designs by a clickable rating 
system. 

Wherever they appear on the list of priorities, business requirements must be clear and succinct and tell 
the web designer exactly what the client is expecting. It is up to the web designer to read and understand 
the requirements before making plans for the site map and wireframes. Therefore, it is necessary for web 
designers to meet with their clients to discuss and clarify each business requirement. Establishing open 
lines of communication and trust with the client will ensure a good business relationship and the best 
possible website.  

Negotiating the “Must Haves” Based on Budget 
In the professional world, clients and web designers make decisions about the features that will be 
included in a site based on budget. Some features that are very nice to have are also very expensive. 
When clients decide what features are absolute “musts,” they make decisions based on how much money 
they can spend on their website. Negotiating features and setting expectations is an important part of a 
web designer’s business—perhaps the most important part. A client may have $1,000 to spend but have 
$10,000 worth of “must” statements, and it is the job of the web designer to determine the cost and 
negotiate the requirements accordingly. Some of the features listed in this reading, such as shopping 
carts and secure logins, can be quite expensive to implement even though they might seem simple from a 
client’s point of view. The reality of time, budget, and expertise may conflict with what the client dreams of 
having.  
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Student Resource 6.3 

Worksheet: Identifying Business Requirements 

Student Names:_______________________________________________ Date:___________ 

Directions: With your partner, read through the list of business requirements in each column carefully. 
Then think of the name of a website you know that fits the list of requirements and write the website name 
at the top of the list. Be prepared to share your answers with the class. 

Site Name: ___________________________ Site Name: ______________________________ 

The site must allow users to post their own video 
clips. 

The site must allow users to create networks with 
other users. 

The site must require posters to log in with a 
password, but users who visit the site do not 
need a password.  

The site must allow users to visit members’ pages 
without a password, but must require passwords for 
users who want to post something. 

The site must allow video viewing without logging 
in. 

The site must allow users to post profile pages. 

The site must have the user grant it a license for 
uploaded material. 

The site must enforce respect of intellectual 
property rights. 

The site must prohibit nudity and content that 
encourages criminal behavior. 

The site must prohibit adult and obscene content. 

The site must allow users access to all postings 
except for adult content. 

The site must limit viewing of detailed information 
about users to their networks or confirmed friends. 

The site must require some users to be 18 years 
or older. 

The site must require users to be 13 years or older. 

The site must contain files with an MP3 audio 
stream. 

The site must have applications that allow users to 
play games with each other. 

The site must convert users’ videos into Adobe 
Flash technology. 

The site must allow developers to use Flash 
technology. 

The site must provide user groups and accounts. The site must help users invite friends to view their 
profiles. 
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Student Resource 6.4 

Sample: Client Intake Form 

Client Name: David Lundholm 

Business Name: Fair Teacher Feedback 

URL (if known): www.fairteacherfeedback.com 

Requirements 
Business Requirements 

 Product: Teacher grading website 

 Look and feel ideas: Pages could look like a real report card; typewriter or 
chalkboard-style font with lined paper? 

 Logos and slogans: Chalkboard with “Students Do the Grading” written on it 

 Usability issues: Different categories of grading 

 Legal/Security issues: Ability to censor unfair comments; only students 
enrolled in teachers’ classes can comment; teachers can comment on their 
report cards 

Content Requirements 

 Purpose of the website: To give teachers honest and fair feedback from their 
students 

 Is there existing content in other formats (PDF, Word, etc.)? FAQs to be provided in PDF 

 Who owns the content? David Lundholm 

 Audience: Students and teachers from local high schools, I hope to spread it 
throughout the state and eventually nationally 

Functional Requirements 

 Personalization (registration, sign-in, newsletters): Registration and sign-in required, 
newsletter to come later 

 Transactions (shopping cart, product selection/review): None 

 Security (registration page, password, shopping cart): Registration page, password 
protection 
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Technical Requirements 

 Expected user volume: 300–500 visitors/month, eventually 50,000+ users 

 Expected peak use time: Afternoons and early evenings, end of grading periods 
when report cards come out, slowest in summers 

 Content that will create high load (audio/video files): None 

 Security requirements: Site should be secure; passwords should be at least six 
characters 

Content Plan 
Text 

 Home: Explanation of how to register, password entry, sample report card 
with notes, logo and slogan, picture of teacher and student 

 About: Why site was started, how it differs from other grading sites 

 Services: Provide kids a way to grade their teachers 

 Orders: None 

 FAQ: Will be provided in PDF format 

 Newsletter: To come later 

Images 

 Logo: To be provided (.jpg format) 

 Captions: I will write them once we get the photos 

 Stock or custom photos provided? Stock photos—teachers and students 
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Student Resource 6.5 

Writing Assignment: Business Requirements 

Student Names:_______________________________________________ Date:___________ 

Directions: Using what you’ve learned in the previous activities, devise eight business requirements that 
address what the client has listed on Student Resource 6.4, Sample: Client Intake Form. The reading in 
Student Resource 6.2 provides guidelines for writing the business requirements. Be sure to write at least 
one requirement from each of the four categories: business, content, functional, and technical. Review 
the assessment criteria before you begin work. 

Your Business Requirements: 
1. 
 

2. 
 

3. 
 

4. 
 

5. 
 

6. 
 

7. 
 

8. 
 

Make sure your business requirements meet or exceed these assessment criteria: 

 The business requirements are appropriate to the site and audience. 

 The business requirements are listed in order of importance. 

 The business requirements address the four categories: business, content, functional, and 
technical. 

 The business requirements use specific details. 

 The business requirements are written as “must” statements. 

 The business requirements are written clearly and succinctly. 

 All text is neat, with proper spelling and grammar. 
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Student Resource 6.6 

Review: Culminating Project Client Intake Form 

Student Names:_______________________________________________ Date:_________________ 

Directions: Meet in your culminating project group and follow the instructions on this resource to 
familiarize yourselves with your culminating project client. Note important information about your client’s 
needs and requirements.  

First Pass: IDEAS 
Read through the client intake form to get a general idea of the client and the client’s needs. What 
impressions do you have? What ideas immediately come to mind for the site? What seems easy to give 
the client? What seems hard to give the client? 

 

 

 

 

 

Second Pass: UNDERSTANDING THE CONTENT  
Take a closer look at the client intake form. What are the main business, content, functional, and 
technical requirements the client is asking for? Write the requirements by category, in “must” sentences. 

Business Requirements 

 

 

 

 

Content Requirements 

 

 

 

Functional Requirements 

 

 

 

Technical Requirements 
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Third Pass: QUESTIONS 
Now that you have really looked at the intake form, what else do you need to know? What is unclear? 
Write your questions down and be ready to ask them of your client. 
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Student Resource 6.7 

Planning Sheet: The Client Meeting 

Student Names:_______________________________________________ Date:_________________ 

Directions: Work with your culminating project group to assign responsibilities to each group member 
before you meet with your client. On the planning sheet below, fill in the name of the person responsible 
for each task and plan out what you want to tell the client and what questions you want to ask. Much of 
the information you need was already prepared during your review of the culminating project client intake 
form (Student Resource 6.6). During the client interview, use this planning sheet to take notes on the 
information you gather from the client. 

Introductions 
Name of person in group responsible for this task:  

 Thank the client for coming and tell the client, in your own words, that your group will work hard on 
his or her behalf. 

 Introduce each member of the group to the client and explain each person’s role during this 
interview. 

 Ask for the client’s business card (if applicable) and write down the following: 

o Client name (or contact person) 
 
 

o Best way to contact the client 
 
 

o Best times to contact the client  
 
 
 

Ideas 
Name of person in group responsible for this task:  

 Ask the client to explain the main goals for the site: 
 

 

 

 

 Ask the client about the audience of the site: 
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 Tell the client what ideas your group has about the site and ask the client to tell you what he or 
she thinks of those ideas and why: 
 
 
 
 

 Tell the client what you think your group will be able to accomplish easily and what will be more 
difficult. Ask the client for feedback: 

 

 

Understanding the Content 
Name of person in group responsible for this task:  

 Read through the business requirements your group wrote. Get the client’s feedback: 

 

 
 
 
 
 

 Read through the content requirements your group wrote. Get the client’s feedback: 
 
 

 

 
 
 

 Read through the functional requirements your group wrote. Get the client’s feedback: 
 
 
 
 

 

 

 Read through the technical requirements your group wrote. Get the client’s feedback: 
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Questions 
Name of person in group responsible for this task:  

 Ask the questions your group came up with and write down the answers: 

 

 

 

 

 

 

 

 

 

 

Collection of Content Materials and Follow-Up  
Name of person in group responsible for this task:  

 Collect all the content the client has: logos, photos, written materials, and so on. Write down a list 
of what you have been given: 
 

 

 

 

 

 

 Thank the client for coming and tell the client you will contact him or her soon. 
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Student Resource 6.8 

Categorization: Productive  
Client-Designer Relationship Strategies 

Student Names:_______________________________________________ Date:___________ 

Directions: With your group members, choose the to-do’s from the second section of this worksheet and 
write them under the correct category. Feel free to add your own ideas to the to-do’s, and be ready to 
discuss your answers with your classmates. Keep this worksheet to remind you how to be the best web 
designer you can be for your clients! 

Categories 
 

Treat Client with Respect 

 

 

 

 

 

Be Prepared 

 

 

 

 

 

Be Honest 

 

 

 

 

 

Keep in Touch 
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Follow Through 

 

 

 

 

 

Be Creative and Flexible 

 

 

 

 

 

To-Do’s 
 Do your homework! 

 Dress and act professionally (shake hands, make eye contact, refer to the client politely). 

 Remember you are working for this person.  

 Do what you say, when you say you will do it! 

 Be ready to suggest alternatives. 

 Keep clients updated on progress even if they don’t ask. This is best to do via email. 

 Give yourself extra time to complete tasks—finish your jobs on time or even early! 

 Tell the client what you can and cannot do—don’t make false promises. 

 Respond to clients within 24 hours. 

 Expect clients to change their minds—this is part of the process. 

 Listen carefully to what the client says and take notes. 

 Read through your notes before you work with the client. 

 Inform clients when change requests are made how much additional time you expect it will take to 
complete the project. 

 Use the phone when necessary; otherwise, email is fine. If the phone is used, it’s always good to 
follow up with a review email to make sure everyone is on the same page. 

 Do your best to give clients what they truly desire. Be objective; many times what the client wants 
is not at all what you want. 

 Have all your materials on hand when you make contact. 

Your ideas: 
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Student Resource 6.9 

Tutorial: Creating a Web Page with a Table 

Student Name:_______________________________________________ Date:___________ 

Directions: In this activity, you will learn how to create a web page that contains a table. For practice, you 
will format the business requirements that you agreed on with your client into a table on a web page. 
Later in this lesson, you will send the page to your client. Follow the instructions below to create this new 
web page. After you create the page, you will link it to your Sample Site Prototype home page. Then, as a 
final step, your group will place this page on a new website for your culminating project. 

Step 1: Create a Table on a Web Page in Your Sample Site 

1. Open Dreamweaver and create a new page with the title “Business Requirements.” Display the 
page in Code view. 

2. In the <body> section of the new page, create an <h1> heading called “Prioritized and 
Categorized Business Requirements.” 

3. Position the cursor after the heading, and go to Insert > Table. 

4. In the Table definition window, make the number of rows equal to the number of business 
requirements you have plus one row for headings, and take the defaults for the other “Table size” 
items. Change the Header definition to Top. Then click OK to create the table template in your 
Business Requirements file. 

 

5. Notice that the first tag in the table template is <table> and that it contains the definitions for the 
table’s width and border. The units of measure are pixels, so you can see that the table is 200 
pixels wide and the borders are 1 pixel each. 
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6. The next few tags define a row (<tr>) and the text for the header rows (<th>). Type in the text 
indicated in the following diagram. 

 

7. The next set of tags (<td>) defines the next row, and you need to type in the text for each column 
in the row. You should type in the first row of your business requirement table here. It should look 
something like the following: 

 

8. Scroll down to the bottom of your file. Notice that Dreamweaver has inserted a table end tag for 
you. Even though Dreamweaver usually closes a tag sequence on your behalf, it’s always wise to 
check that all your opening tags also have end tags. 

 

9. Switch to Design mode to see how your table looks so far. As you can see, the table is much too 
narrow! 

 

10. Switch back to Code view and scroll to the top of your table, where the table width is defined. A 
width of 200 pixels is too narrow for this three-column table. Change the width to something that 
seems more logical, given the amount of text you have in the middle column. 

11. Check your table again in Design view. 

12. Continue to experiment with the width until it looks right. 
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13. Save your web page in your Sample Site web_pages directory as business_requirements.html. 

14. Fill in all of the rows of the table with your other business requirements. 

15. Check the appearance of the table in Design view, especially the table width. 

16. Save your work. 

17. Open your Sample Site Prototype home page and link in the Business Requirements page, just as 
you did the other web pages. 

Step 2: Create a Project Site with Your Business 
Requirements Page 

1. Choose one group member’s business requirements page to place on your culminating project 
site.  

2. Have one group member set up a Culminating Project Site directory for your culminating project 
site. This directory should have the same structure as your sample site, with subdirectories named 
web_pages and images. 

3. While one group member is working on creating the directory, have other group members 
proofread the business requirements page you plan to place on your culminating project site, to be 
sure it is absolutely correct. 

4. Save this business requirements web page in the web_pages directory of your culminating project 
site so that it will be accessible.  

Your Sample Site So Far 
The web_pages directory in your Sample Site Prototype should now have the following files: 

 about_me.html 

 about_me_professional.html 

 about_us.html 

 business_requirements.html 

 tips_techniques.html 

 useful_links.html 

In addition, you have index.html in your root directory. 

Your Culminating Project Site So Far 
So far you should have a copy of your team’s Business Requirements page in the web_pages directory of 
your culminating project site. 
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Student Resource 6.10 

Email Guidelines: Writing a Follow-Up Email 

Directions: Use the guidelines below to help you create a concise, professional email to your client as a 
follow-up to your interview. Your email should include the items listed in the email message guidelines 
below and also express your interest in working with the client on the client’s website. Start by writing a 
rough draft, and have every group member cover one or two of the points in your email. Then combine 
your work into a final email and refine it so that all the parts fit together. Make sure you remember to 
attach your HTML page with your business requirements to your email. 

Many people think email is only a casual form of communication and therefore that the standard rules of 
grammar and etiquette do not apply. This may be true when composing quick, casual emails to friends or 
family, but emails written to a client or a potential employer should be as professional, clear, and concise 
as any business letter. A professional email will give your work credibility and indicate to clients that they 
should take you seriously. 

Remember that an email can make or break your relationship with your client. If you need to email a client 
about a prickly subject that has upset you, it is wise to save your email as a draft and review it a few 
hours later. This can help you cool off and approach the subject in a constructive and courteous manner. 

Email Guidelines  

 Get a proper email address. Make sure you use an email address that gives you a professional 
identity. If you don’t have one, ask your teacher for help getting one. 

 Add a clear subject line. Make it obvious why you are writing so that the recipient is motivated to 
open and read your message. 

 Use proper spelling, punctuation, and grammar. Leave a good impression of you and your skills. 

 Do not use “all caps.” All capital letters imply screaming and are more difficult to read. 

 Open with a professional, friendly greeting. Begin the email as if you are writing a business letter. 

 Put a concise, clear message at the beginning of the email. Get to the point quickly so that your 
email is not skipped or deleted. 

 Keep content professional throughout the body of the email. Do not use informal terms, 
emoticons, or “text speak.” 

 Be thorough. Make sure your email includes the following: 

o A restatement of the main points of the meeting 

o The client’s top priorities for the website 

o The additional features of the website the group will try to incorporate 

o Any concerns or questions you have or items that need more explanation 

o An attachment with the HTML page listing your business requirements 

o The next steps you will be taking 

o A thank you to the client for the opportunity to work with him or her 

 End with a courteous closing. Leave your client with a good feeling about you and your work. 

 Read your entire message before sending. Be sure your tone and message are as you intended. 

 Follow up. If necessary, telephone to be sure your client received your email. 
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Student Resource 7.1 

Research: Site Maps   

Student Names:_______________________________________________ Date:___________ 

Directions: With your partner, open the first three links below and explore the websites by using the site map. Then respond to the questions and 
prompts in the chart below. After you have completed the chart, look at the fourth link to explore common types of site maps. Be prepared to share 
with the class which style of site map you prefer and why. 

Adobe TV: http://tv.adobe.com/sitemap/  

ESPN: http://espn.go.com/espn/sitemap  

University of California: http://graduate.universityofcalifornia.edu/admissions/a-z-index/index.html  

Types of Site Maps: http://webaim.org/techniques/sitetools/ 

Questions and Prompts Adobe TV ESPN University of California 

What style is the site map: alphabetical, 
structural, or graphical? 

   

Click the logo in the upper left corner. 
Then, without using the Back button, find 
the site map again. Describe where you 
found the link to the site map. 

   

Rate the site map on its ease of use:  
1 = difficult to use, 5 = easy to use.  
Give at least one reason for your choice. 

   

Rate the site map on its visual appeal:  
1 = not appealing, 5 = very appealing. 
Give at least one reason for your choice. 
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Student Resource 7.2 

Tutorial: Creating a Textual Site Map 

Directions: In this exercise, you will create a textual site map for your sample site that looks similar to the 
CNN site map below. Follow these instructions to create the site map and link it to your sample site’s 
home page. 

Step 1: Examine the CNN and Sample Site Textual Site Maps 
Look again at the CNN site map in the diagram below. Notice that it is a three-level map (it has three 
levels of navigation), with CNN.com as the top level, and various second-level links (for example, “World 
news”) below that. Each second-level link has one or more third-level links (for example, “Europe News 
Archive”). 

Next, look at what a textual site map for your sample site is likely to look like. Note that a third level of 
pages has been added under “Useful Links.” In this tutorial, you will be creating these resource pages 
and then creating your site map. 

 

 

Step 2: Create Two Third-Level Pages under “Useful Links”  

1. Open Dreamweaver, and then open your sample site’s index.html page, which contains links to all 
your other web pages. This will put you in the right directory. Then close your index.html page. 

2. Create a new page in Dreamweaver, the same way you created your existing web pages. Be sure 
you select the defaults shown in the following screenshot. 
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3. Give your new web page the title Dreamweaver Resources and save the file as 
dreamweaver_resources.html in the web_pages directory. 

4. Create another new page with the title Other Resources and save it as other_resources.html in the 
web_pages directory. 

5. Open your Useful Links page. You should now have three pages open in Dreamweaver: 
Dreamweaver Resources, Other Resources, and Useful Links. 

6. The next step is to move the text on your Useful Links page to your Dreamweaver Resources 
page and your Other Resources page. Copy and paste the heading and links in the Dreamweaver 
Resources section of your Useful Links page to your new Dreamweaver Resources page. 

In Design view, your Dreamweaver Resources page should now look like the following 
screenshot. 

 

7. Copy and paste whatever additional headings and links you currently have in your Useful Links 
page to your new Other Resources page. 

Your Other Resources page should now look something like the following screenshot. 



AOIT Web Design  
Lesson 7 Planning an Effective Website 

Copyright © 2008–2015 National Academy Foundation. All rights reserved. 

 

8. The next step is to change your Useful Links page into a page that links to your two resource 
pages. Delete the existing headings, text, and links from your Useful Links page, since you have 
already copied them to your resource pages.  

9. Replace the text you deleted with links to the new Dreamweaver Resources and Other Resources 
pages. Be sure your links reflect the fact that all three web pages are in the same directory. (Even 
though you are adding a third level in the hierarchy of your website, you are not adding another 
level to your directory structure.) 

If you have trouble creating the links, look at the code for your home page.  

Your Useful Links page should now look like the following. 

   

10. Close all pages that you currently have open. 

Step 3: Create a Site Map Page for Your Sample Site  
Follow the steps below to create a textual site map that looks like the CNN site map. Notice that the CNN 
site map is a set of page links constructed as a multilevel unordered list. 
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1. Create a new page using the same basic Dreamweaver layout as before. Name it Site Map and 
save it in the web_pages directory as site_map.html. Be sure you are looking at the Site Map page 
in Code view. 

2. Inside of paragraph tags, create a link to your home page (index.html). Remember that your link 
needs to take into account the fact that your home page is not in the same directory as your Site 
Map page. 

   

3. While you are still on your Site Map page, add an unordered list of all the second-level pages in 
your hierarchy, and create a link to each page. Remember that all these pages are in the same 
directory as Site Map, and that you have six pages to link in. 

4. Save your file and look at it in Design view.  

5. Link in your third-level pages (Dreamweaver Resources and Other Resources) using an unordered 
list within your original unordered list. Remember that these new pages come after Useful Links 
and will appear below it in the list hierarchy.  

The diagram below shows how to do this tricky structure. 

 

6. Save your file again and check it in Design view. It should look like the following screenshot. 
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7. Open your home page (index.html) in Dreamweaver and link in your new Site Map page below the 
existing links.  

8. Check your home page in Design View. 

9. Save your home page. 

10. Check your home page in a browser. It should look like the following screenshot. 

 

Your Sample Site So Far 
The web_pages directory of your sample site should now have the following files: 

 about_me.html 

 about_me_professional.html 

 about_us.html 

 business_requirements.html 

 dreamweaver_resources.html 

 other_resources.html 

 site_map.html 

 tips_techniques.html 

 useful_links.html 

In addition, you should have an index.html page in your root directory. 
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Student Resource 7.3 

Defining Format Chart: Wireframe Terms 

Student Names:_______________________________________________ Date:___________ 

Directions: This guide will help you understand wireframe terms and why each component is important in 
the creation of a wireframe. In the chart below, first enter a category for each term. In the next column, list 
characteristics of the term as you would see in a dictionary definition. 

Term Category  Characteristics 

A jump menu 
is a   

 

A multi-tier 
menu is a   

 

A navigation 
bar is a   

 

A page footer 
is a   

 

A page header 
is a   

 

Text-only 
navigation is a   

 

A tree-style 
menu is a   
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Student Resource 7.4 

Sketch: Wireframe with Content Placement 

Directions: Review the sample wireframe below for www.netflix.com. (Note: Netflix has updated the 
design of its site since this wireframe was drawn.) Then select a web page from the list below and, on a 
separate sheet of paper, create a wireframe of that page using only a pencil and a ruler. Include only text, 
lines, and simple shapes to depict the layout and main components of the page. Indicate the navigational 
structure, menu style, graphic/media areas, content placement, global links, and interactions. You do not 
need to sketch any subpages. 

  

 

 http://www.nytimes.com/ 

 http://www.oracle.com/ 

 http://www.ebay.com/ 

 http://www.barnesandnoble.com/ 

 http://www.usa.gov/ 

 http://www.zazzle.com/  
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Student Resource 7.5 

Assignment Sheet:  
Creating a Site Map for Your Client’s Site 

Directions: As part of your culminating project, devise a site map for your client’s website based on the 
knowledge you gained in the previous activities and from your client’s intake form. Use this procedure to 
create your site map. 

1. List all of the website’s content. 

2. Start the information design by categorizing the content into specific pages. 

3. Create a box to represent each page. 

4. Create a navigational scheme by categorizing the boxes and placing them in the proper hierarchy. 

5. Draw lines connecting the boxes to represent the flow of the information. 
 

Make sure your site map meets or exceeds the following assessment criteria: 

 The site map contains all of the pages in the website (10 maximum for this project), with a title 
and brief description of each page.     

 The site map begins at the home page and shows a correct navigational scheme to all subpages.  

 The site map contains links to global pages such as contact information, About, news, search, 
and so forth.  

 The site map accurately integrates the client’s functional needs into the design.  

 The site map is neat, clear, presentable, and professional.  
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Student Resource 7.6 

Tutorial: Selecting a Site Layout Based on a 
Wireframe Drawing 

Directions: When you draw a wireframe for your website, you need to make sure you will be able to 
achieve the design when you start building the layout of your website. For your culminating project 
website, you will start with the predefined Dreamweaver layout that most closely meets the requirements 
specified in your wireframe. You can make modifications to the predefined layout you choose, but it will 
be helpful to have some idea of the layouts Dreamweaver proposes before you create your wireframe for 
your culminating project site. To get some practice with predefined layouts in Dreamweaver, follow the 
instructions in this tutorial to select a Dreamweaver layout that is most suitable for your sample site.  

Step 1: Create a Directory Structure for Sample Site Final 
On your local network or flash drive, in the location specified by your teacher, set up a directory structure 
exactly as shown in the following diagram. 

 

Notice that this directory structure has one more directory than the structure you created for Sample Site 
Prototype in Lesson 5. It has a “templates” directory. You will add a template file to that directory in a later 
lesson. 

Step 2: Define the Site as a Dreamweaver Entity 

1. Open Dreamweaver and select Site > New Site, as shown in the following screenshot. 

 

2. In the Site Setup dialog, navigate to the location of your Sample Site Final project. Name your 
project SampleSite_Final and click Save. 
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Step 3: Examine the Wireframe for Your Site 
Assume that the following diagram is the wireframe that will be the basis for your new site’s layout. All the 
pages on the site will use this same layout.  

The wireframe below is a rather typical design that consists of two columns (the one on the left is mostly 
for navigation, and the one on the right is for page content), a header that can also accommodate 
additional navigation, and a footer. 

 

Dreamweaver has many prebuilt layouts to choose from, and you need to think about the prebuilt layout 
you will choose in order to ensure that your wireframe represents a page you can actually construct with 
Dreamweaver.  

Follow these steps to choose the layout that best matches the wireframe design you are working from: 

1. Select File > New. 
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2. Before you choose the layout for your new file, spend a little time exploring the possibilities. 

As you can see in the following diagram, there are many prebuilt DW layouts to choose from. Click 
each one in turn, observe its preview to the right of the Layout panel, and look for the one that 
most closely matches the wireframe diagram on the previous page. 

 

The image below is what you might see in the preview pane. In this layout, you can see that the 
sidebar, which is mostly for navigation, is the narrower column on the left and the content area is 
the wider column on the right. 

 

Which of the DW layout possibilities most closely matches the sample wireframe?  
 
Your choices will most likely come down to “2 column fixed, left sidebar, header and footer” or “2 
column liquid, left sidebar, header and footer.” A fixed design does not “squeeze in” when the 
browser window is made smaller, whereas a liquid design does. We are going to concern 
ourselves only with fixed designs for now, so your selection should be “2 column fixed, left 
sidebar, header and footer.” 
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3. Select that choice, take the DocType and Layout CSS defaults, and click Create. 

  

4. Be sure you are in Design view. Your DW workspace should look like the following screenshot. 

 

5. Title your new page My Layout. 

6. Save the file in your Sample Site Final root directory as mylayout.html. 

 
In the next lesson, you will work on the look and feel of this layout. For right now, you just need to know 
how to choose a layout that will work with your wireframe. 

Your Sample Site Final So Far 
So far, your Sample Site Final should have a file called mylayout.html in the root directory.  
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Student Resource 7.7 

Assignment Sheet:  
Creating Wireframes for Your Client’s Site 

Directions: Create wireframes for your client’s website based on the knowledge you gained in the 
previous activities and from your client’s intake form. Use this procedure to create your wireframe. 

1. Sketch simple shapes and lines to designate the main components of each page (navigation, 
content areas, graphic/media areas, logo). 

2. Using Dreamweaver, find the layout that most closely resembles your sketch, and note the name 
of this layout so that you can use it when you create your site. Note that you can adjust the layout 
to match what you need for your client, but you want to create a layout that is reasonably close to 
a predefined Dreamweaver layout. 

3. Illustrate the content hierarchy with sample headers, titles, body text, and so on. 

4. Divide and label the navigation area to illustrate the specific links and requirements for menus. (It’s 
best to wait until you’re farther along in the design process to decide on a specific menu style.) 

5. Add other elements such as global pages, login areas, search boxes, site map, and so on. 

6. On subpages indicate any other navigation tools such as a breadcrumb trail or button changes. 

7. Add labels and side notes to provide further description for each area (e.g., label the logo with a 
number and add a side note indicating that the logo always links to the home page). 

8. Include an inventory of important items such as logos, company title, and important graphics, even 
though you may want to determine the best placement for these items later in the design process. 

 

Make sure your wireframes meet or exceed the following assessment criteria: 

 The wireframes are text and simple line diagrams only, and depict the general page layout for at 
least one page of each level (home, secondary, tertiary, etc.). 

 The wireframes indicate the general placement and quantity of interactive elements, 
media/graphics, content areas, and links. 

 The wireframes indicate requirements for menus. 

 The wireframes indicate how to navigate home, how to determine the current location, and how to 
access the site map.  

 The wireframes contain links to global pages such as contact information, About, news, search, 
and so forth.  

 The wireframes accurately integrate the client’s functional needs into the design.  

 Wireframe inventory items include the company’s title, logo, and important graphic images. 

 The wireframes are neat, clear, presentable, and professional. 
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AOIT Web Design 

Lesson 8 
Principles of Design 

Student Resources 

Resource Description  

Student Resource 8.1 Reading: Principles of Design 

Student Resource 8.2 Web Hunt Chart: Design Principles 

Student Resource 8.3 Tutorial: Modifying the Layout of a Web Page 

Student Resource 8.4 Tutorial: Adding a Navigation Bar and Logo to a Website Layout 

Student Resource 8.5 Tutorial: Moving CSS Rules to an External Style Sheet 

Student Resource 8.6 Proposal: Client Website Look and Feel 

Student Resource 8.7 Example: Look and Feel Proposal 
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Student Resource 8.1 

Reading: Principles of Design  

 

 

This presentation will provide you with a more in-depth understanding of the principles of good website 
design. It will also help you think about how to make your own client sites more user-friendly and 
successful. 
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The design of a website gives a strong first impression; it provides the identity, character, and purpose of 
the site; and it helps the user understand how the site works. 

Why do you think Google keeps such a simple design for its home page? 

Google has an incredibly simple design, color scheme, and message. The user should immediately know 
what they can do on the site and where they should go to do it. 
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Creating an effective website requires careful work in each of these areas: 

Content drives the site. What content is important and what is less important? How can I emphasize 
that? 

Functionality makes the content accessible, and makes it easy to find additional content on the site. 

Navigation is a special subset of functionality that ensures users can find what they need on your site 
from where they are right now. 

Visual design ties content, functionality, and navigation, along with the client’s brand, into a coherent 
whole. 

Media enhances the visual design and content, but should always serve a purpose. For example, 
animation is cool, but animation that doesn’t do anything important is going to be a distraction and not an 
enhancement. 
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Content should be broken up into clearly defined areas. 

• Groupings should help users find what they need quickly. 

• Out-of-date or inaccurate content can turn off site visitors. 

• People typically do not read long paragraphs of text on general information pages—short, concise 
headlines or bullet points are better for the web. Links can lead to more in-depth information for 
people who are interested. 

• There should not be too many fonts. For beginners, the best practice is to start with two fonts: 
one for headlines and one for body copy. Chosen fonts should be dissimilar enough to make it 
clear they’re not the same font.  

• Avoid text that is animated and moving! Consider using font size as a way of visually layering 
information to make it easy to scan the site quickly. (For example, if headings are bigger than 
body text, you can quickly scan the headings.) 

• Clickable elements should be obvious. 

Think about your actions on the web. When do you read long paragraphs of text, and when do you skim 
information? 

The New York Times online pages use headlines with only a short bit of content—best for skimming. 
Categories are in logical, clear sections. Fonts are clear, consistent, and sized appropriately and 
represent the hierarchy of information. 
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A site should definitely not have any errors when viewed with recent versions of common browsers and 
platforms. Ideally, it will have no errors no matter what platform or browser it is viewed on. (Sometimes 
budget may not allow for making the site function properly in a really old browser.) 

• Broken links, error messages, or excessive wait times create a poor user experience, even if the 
content of the site is fantastic.  

• Users should always be able to find and get to where they want to go—no dead ends!   

• Ideally a site URL will be short and memorable to users. A short URL also increases a site’s 
search engine ranking. 
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Site navigation should be clear, logical, and consistent throughout the entire site. At any place in the site, 
users should be able to tell where they are, find where they need to go, and know how to return home. 
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Visual design affects both the practical and the emotional perception of a site. It provides the first 
impression of a site and affects the user’s experience and desire to return to the site.  

Think about the overall visual design of this site: 

• Is your initial perception of the site pleasing? 

• Can you immediately understand its purpose? 

• Is there good (or any) use of white space? 

• Is the color scheme appropriate and pleasing? 

• What about the background? 

• Does the layout and navigation help you know where to go and what to do? 
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Graphics and media can greatly enhance a site, but too many bells and whistles can detract from the site. 

• Slow-loading media or poor-resolution graphics create a negative user experience. 

• Irrelevant or inconsistent icons, buttons, and such can confuse the user. 
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These five elements are the foundation of a successful website. Be sure to pay careful attention to them. 
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Student Resource 8.2 

Web Hunt Chart: Design Principles  

Student Names:_______________________________________________ Date:___________ 

Directions: Your group will be conducting a web hunt in order to find examples of both good and bad web 
design. Your teacher will provide you with the URLs of a number of different websites. When it is time to 
begin, your team will review these websites with a critical eye. Look for at least one site that meets the 
following web design criteria and one site that does not. You have only 15 minutes to list the name and 
URL of at least one site for as many principles as possible. When time is called, you must stop your web 
search, and your teacher will lead a discussion on your class’s findings. 

Content Criteria  Website That Follows  
This Principle 

Website That Does Not 
Follow This Principle 

The content is mapped into logical categories with 
appropriate labels, so it is easy to find. 

  

All content is up-to-date, accurate, not offensive 
to the intended audience, and uses a consistent 
tone. 

  

Text is written for the web: clear and concise, with 
short bullet points, hierarchies, or other 
organizational tools. 

  

Appropriate methods of contact are provided 
(phone number, address, email, feedback form). 

  

The site has a privacy and/or legal statement 
page if it collects user information. 

  

The site provides clear instructions when actions 
are required by the user. 

  

Links and visited links are made obvious through 
color and are a relevant part of the readable text 
(“click here” is not used). 

  

High-contrast, appropriate fonts are used 
consistently, at the correct size, without 
movement or much variation, and they represent 
the content hierarchy. 

  

Site is appropriate to target audience.   

Pages have meaningful title tags.   



AOIT Web Design  
Lesson 8 Principles of Design 

Copyright © 2008–2015 National Academy Foundation. All rights reserved. 

Explain your conclusions: 

 

 

 

 

 

 

Functionality Criteria Website That Follows  
This Principle 

Website That Does Not Follow 
This Principle 

The site does not generate any 
errors, and all links are working. 

  

The site works on all browser 
platforms and versions. 

  

The site loads quickly.   

Registration is not needed to see 
basic information. 

  

The Back button is not disabled.   

A site map and/or site search 
engine is available. 

  

The site has a short, memorable 
URL. 

  

Explain your conclusions: 
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Navigation Criteria Website That Follows  
This Principle 

Website That Does Not Follow 
This Principle 

Site navigation is clear and logical 
and persists throughout the entire 
site. (Users can always tell where 
they are, find where they need to go, 
and figure out how to return home.) 

  

When appropriate, additional 
shortcuts/navigation methods are 
used (breadcrumb trails, menus, 
etc.). 

  

The logo is in a highly visible spot 
and always leads to the home page. 

  

Explain your conclusions: 
 
 

 
 

Overall Visual Design Criteria Website That Follows  
This Principle 

Website That Does Not Follow 
This Principle 

The overall design is visually 
appealing and professional and  
clearly represents the organization  
or website’s purpose. 

  

The site has a consistent look on 
each page. 

  

The color scheme is simple and 
elegant and represents the 
company or products. 

  

The background color or design is 
simple and does not interfere with 
the body of the page. 

  

Infographics are used effectively to 
draw in the visitor or to 
communicate complex information. 

  

Explain your conclusions: 

 

 



AOIT Web Design  
Lesson 8 Principles of Design 

Copyright © 2008–2015 National Academy Foundation. All rights reserved. 

Media Criteria (Graphics, Video, Animation, 
and Audio) 

Website That Follows  
This Principle 

Website That Does Not 
Follow This Principle 

All media conveys meaning and enhances the 
site. There are not too many bells and whistles. 

  

All media is of the highest quality, is optimized for 
the web, and contains alt text. 

  

Symbols, buttons, and icons are appropriate, 
consistent, and relevant. 

  

Explain your conclusions: 
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Student Resource 8.3 

Tutorial: Modifying the Layout of a Web Page 

Directions: In this tutorial, you will learn how to modify the layout of the mylayout.html page you created in 
Lesson 7. Follow your teacher’s instructions for working through the tutorial.  

Step 1: Examining the Style Information for a Web Page 

1. Open the mylayout.html file in your Sample Site Final root directory. Be sure you are in Design 
view. Your DW workspace should look like the following screenshot: 

 

2. Look at all the elements on the layout page and read through the instructions in the content area of 
the page. 

3. Switch to Code view. Notice that most of what you see on the page pertains to the layout or style 
of the page, rather than textual content. Look for the opening <style> tag, which is near the top 
of the page. Everything between the opening and closing <style> tags is CSS (Cascading Style 
Sheets) coding. 

As you can see, the styling information for “body” includes fonts, colors, and spacing. 

 

4. Page down until you see the closing <style> tag (at approximately line 129, above the opening 
<body> tag). 
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5. Notice the “divisions,” or sections, of the page body, which are delineated by <div> tags. In this 
sample layout file, there are five “divs”: container, header, sidebar1, content, and footer. 

Page through the file again looking for items you think you might be able to modify yourself. At this 
stage of your web design career, you may not yet be ready to do complicated CSS coding, but you 
should be able to figure out how to do some “safe” modifications.  

How can you tell what’s safe and what’s not? Take a look at approximately line 43, which defines 
some aspects of the container division. 

 

The fixed width is 960 pixels, and the container “surrounds” the other divisions such as header 
and content. If you changed this width, it would very likely negatively affect all other elements of 
the design, so this would not be a good modification to try. On the other hand, changing a color is 
usually okay, as long as you remember what the original color was so that you can undo your 
modification if necessary. 

6. Go ahead and modify the background color in the container section from #FFF to #090 (green). 

7. Switch to Design view to see what happens. (The white background color for the content area is 
now green.) 

 

8. Since green is not a good background for text, switch it back to white (#FFF). 
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Step 2: Add a Live Link and Modify the Page Content 
Now that you are familiar with the code on your layout page, you’re ready to start creating links to real 
pages in the menu bar and adding text to the content section. 

Place a File in Your Sample Site Final Directory 

1. All of the pages that your site links to should be placed in the web_pages directory of Sample Site 
Final. For now, open Windows Explorer and copy the Tips and Techniques page 
(tips_techniques.html) from the web_pages directory of Sample Site to the web_pages directory of 
Sample Site Final. 

Put a Live Link in the Left Navigation Area  

2. Go back to the My Layout page in Dreamweaver and switch from Design view to Code view. In the 
body of the page, find the sidebar1 division (at about line 136, but the line number may vary): 

 

3. The links in the left navigation sidebar have been defined as placeholders, using the “pound” or 
“hash” (#) symbol. Make the top link (line 138 in the image above) live by replacing the hash 
symbol with a real link to your Tips and Techniques page. 

Remember that you need to go down one directory level (through the web_pages directory) to 
reach the Tips and Techniques page. 

 

4. Replace the placeholder text (Link one) with Tips and Techniques. Switch to Design view to be 
sure the name of the link has changed. 

5. Save your My Layout page. 

Edit the Content of My Layout Page 

6. Be sure you are in Code view in the My Layout page. 

7. In the body, find the top of the content <div>. 
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8. Delete all the text in the content section except the text in the <h1> tag. 

9. Replace the <h1> text (“Instructions”) with “Welcome to My Layout Page!” 

10. Switch to Design view and check the page. Save your My Layout page. 

Your My Layout page should look something like the following screenshot. 

 

Step 3: Examine Your Page in a Browser 

1. Open your My Layout page in a browser. It should look like the following screenshot. 

 

2. Hold the mouse cursor over the “Tips and Techniques” link. It should look like the following 
screenshot. 
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3. Click the link to display the Tips and Techniques page. 

The Tips and Techniques page is still the plain, black-and-white page you originally created. It has 
none of the attractive colors, layout, or styling of your My Layout page. Dreamweaver pages don’t 
automatically inherit the styling of other pages in a website project. 

Later in this lesson, you will learn how to make your entire Sample Site Final reflect the new, more 
attractive styling of the My Layout page, but for now, just leave the Tips and Techniques as it is. 

4. Return to the My Layout page by using your browser’s Back button. 

Notice that the styling of the Tips and Techniques link is the same as it was when you were 
hovering over the link, even though your cursor is no longer positioned over the link. 

5. Go back to Dreamweaver, and be sure you are in Code view. 

6. Go to approximately line 84. 

The CSS code between lines 84 and 103 controls the behavior and styling of the links in the left 
navigation bar. As you can see, the code has a number of comments explaining how it works. 

  

7. Read through the code and the comments. If you need to remind yourself of the link behavior, go 
back to the browser and try it out. 

8. Save the My Layout page. 

Your Sample Site Final So Far 
The web_pages directory in your Sample Site Final project should have the following file: 

 tips_techniques.html 

In addition, your root directory should contain mylayout.html.  
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Student Resource 8.4 

Tutorial: Adding a Navigation Bar and Logo to a 
Website Layout  

Directions: In this activity, you will add new features to your mylayout.html page. Follow your teacher’s 
instructions for working through this tutorial. 

Step 1: Add a Top Navigation Bar 
In this section, you will refine your layout by adding a top navigation bar in the right area of the page 
header. 

1. Use Windows Explorer to copy your index.html and about_me.html files from your Sample Site 
project to your Sample Site Final project. Be sure to put them in the appropriate location: 
index.html should be in your root directory, and about_me.html should be in your web_pages 
directory. Be sure also to copy all of the images in the images folder over to the images folder in 
your Sample Site Final directory—you’ll need them for your About Me page. 
 
In your Sample Site Final directory, take a moment to clean up index.html by deleting the following 
links, since you won’t be copying over the files associated with them: “About Me Professional,” 
“About Us,” “Useful Links,” “Business Requirements,” and “Site Map.”  

You are now going to link to the Index and About Me pages from your mylayout.html page. 

2. If your My Layout page (mylayout.html) is not already open, open it in Dreamweaver and view it in 
Design view. It should look like the following screenshot. 

 

So far you have only a left navigation area. In this exercise, you will add a top navigation area in 
the page header. 

3. Switch to Code view and add a <div> for the top navigation area to the <body> part of your 
layout page in the location indicated in the following screenshot. Be sure to put in placeholder text 
for the links indicated (“Home” and “About Me”). 
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4. Switch to Design view. Your layout page should now look like the following. 

 

5. Notice that the navigation bar is on the left, not the right (you want it on the right), and that the 
navigation bar is not styled. 

6. Switch back to Code view. 

7. First, you will make the links live. Link “Home” to your index.html page, as shown in the following 
image. 

 

8. Look at the link in Design view. 

9. Save the file, and then check the link in a browser. If the link doesn’t work correctly, check your 
code and make corrections. 

10. Follow the same procedure to link “About Me” to about_me.html. 

 

11.  Save the file and then check the link in a browser. 

12. Next, you will style the top navigation bar. Make sure you are in Code view, and in the location 
indicated in the following image, type in the styling rules. Be sure to do it exactly as indicated! 
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13.  Switch to Design view. Your top navigation bar should now be on the right (text-align: 
right;). The background color is now green (#090). The border bottom is dark green (#060). 

  

14. Save the file and check the appearance, behavior, and links in a browser. 

Step 2: Add a Logo 
In this section, you will add a logo to the top left of your page and make it a live link to your home page. 

For this exercise, you will need an image sized to 180 pixels wide by 90 pixels to use as a logo. Be sure 
to put your logo in the images directory of your Sample Site Final. 

1. Look at your My Layout page in Code view and find the <div> with class “header,” as shown in 
the following screenshot. 
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2. Notice that there is a placeholder link for the logo (#) and that the alt text is “Insert Logo Here.” 
Currently the alt text is displayed because the logo is not there yet. Notice that the size of the logo 
is already specified as 180 by 90 pixels. You could change this, but the logo might not fit in the 
header. Leave the dimensions the way they are. 

3. Inside the <img> tag, in the src attribute, insert a link to your logo in the images directory. Update 
the name and id attributes as well (give the logo a name and an ID based on the file name, as 
shown in the following screenshot). 

4. Replace the alt text (in the alt attribute) with “[name of site] -- return to home page.” (Alt tags 
should be descriptive like this to be most useful to people with disabilities. If an image is linked, the 
alt tag should describe the link action.) 

 

5. Switch to Design view to be sure your link is correct and that the logo shows up in the header, and 
then switch back to Code view. 

6. Insert a link to make the logo into a “hot spot” that links to your home page. 

 

7. Save the file, check the appearance in Design view, and check the link in a browser. 

Step 3: Document Your Layout 
In this section, you will add a few notes to the content area of your layout to remind you of the features 
you have added to the original Dreamweaver layout. 

1. Look at your My Layout page in Code view and put your notes in the content area of your file, 
below the “Welcome” heading. Write your notes either as sentences in paragraphs or as bulleted 
items. 

Here are two suggestions to get you started: “I created this layout page from a prebuilt DW page 
called…” and “I added a top navigation bar…” 

Include information that you think would be useful to you or to one of your fellow students who was 
using your layout as a model. 

2. Save your file and switch to Design view to look at the finished product. Your layout page should 
look something like the following screenshot. 
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Your Sample Site Final So Far 
You did not create any new web pages in this activity, but the following pre-existing pages have now been 
linked in to mylayout.html, either in the left or top navigation area: 

 index.html (root directory) 

 about_me.html (web_pages directory) 

 tips_techniques.html (web_pages directory) 

You added a logo to the images directory, which should also now contain the image files associated with 
your About Me page.  
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Student Resource 8.5 

Tutorial: Moving CSS Rules to an External Style Sheet 

Directions: When you are still in the prototype stage of your web page design, it is easier to have your 
CSS embedded in your layout page, as you have with your My Layout page. However, embedded CSS 
styles can apply only to the one web page they are embedded in. When you create your client site, it will 
contain multiple pages, all of which need to rely on the same CSS rules. Follow the steps in this tutorial to 
practice moving CSS rules from the <head> section of your My Layout page to a file of their own. 

1. Open your MyLayout.html file in Dreamweaver in Code view. 

2. In the CSS Styles panel on the right, click the All tab. 

3. Select the first defined style, body. Hold the Shift key and select the last style,  
#h-navbar a:hover. 

 

4. In the CSS Styles panel, in the Options menu in the upper-right corner of the panel, choose Move 
CSS Rules. 
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5. When the Move to External Style Sheet dialog box appears, choose “A new style sheet” in the 
“Move Rules To” options. Click OK. 

 

The Save Style Sheet File As dialog box appears. 

6. Navigate to your root folder, if necessary. Save your new CSS file as mystyles.css. 

Dreamweaver adds the .css extension automatically, moves the styles you selected from the 
<head> area to the new style sheet, and links your mylayout.html file to the new style sheet. 

7. Be sure your mylayout.html file is in Code view. Go to the top of the file and delete the remnants of 
the <style> tag (<style>, </style>, and both lines in between). 

8. Be sure the link to the new external style sheet appears where it should. 

 

9. Notice at the top of the document window that the name of your new external style sheet is 
displayed in the Related Files interface. 

 

10. Choose File > Save All to save both mylayout.html and mystyles.css.  

In the future, remember to use the Save All command whenever you are working on HTML files 
and their related CSS file.  

  



AOIT Web Design  
Lesson 8 Principles of Design 

Copyright © 2008–2015 National Academy Foundation. All rights reserved. 

Your Sample Site Final So Far 
The web_pages directory in your Sample Site Final project should have the following files: 

 about_me.html 

 tips_techniques.html 

Your images directory should contain the images for your About Me page and your logo. 

Your root directory should contain: 

 index.html 

 mylayout.html 

 mystyles.css 
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Student Resource 8.6 

Proposal: Client Website Look and Feel  

Directions: As part of your culminating project, create a “look and feel” proposal for your client’s website, 
based on the purpose statement you created earlier in this lesson. Your group should replicate the 
structure of the look and feel proposal in Student Resource 8.7, but customize the content for your 
particular client. The checklist below contains the criteria upon which your proposal will be assessed. 

Proposal Contents 

Summary of Client Requirements 

The first page should contain the client identifying information (name, company, URL), as well as a brief 
summary of each of the four client requirements below. This will indicate to your client that you have read 
and understood his or her intake form and have integrated the client’s thoughts and needs into your 
design proposal. 

Business Requirements: Summarize how your look and feel proposal addresses the client’s business 
functions, processes, and standards. 

Content Requirements: Summarize how your proposal addresses the content that will be used on the 
site. 

Functional Requirements: Summarize how your proposal defines the functions that the website needs 
to support to meet the business requirements and user expectations. 

Technical Requirements: Summarize how your proposal addresses the requirements that ensure the 
website functions properly and supports the number of users who visit it. 

Mock-Ups 

The next few pages should contain sketches or computer representations of the look and feel for your 
client’s website home page. Each design should contain the basic color scheme, graphic elements, 
navigation, and text area, per the web design principles you learned in previous activities. At least two 
different options must be proposed, but you may do more if you prefer. (No more than four options should 
be proposed.) Remember, these are not final designs, but rather design directions for your client to 
review before providing you with preferences and changes. 

As you sketch out your proposed designs, make sure you are confident you can implement them in 
Dreamweaver using the basic techniques you used in creating and modifying the layout for your sample 
site. The design for your client’s site does not have to be exactly like the design for your sample site, but it 
should not be so complex that it would be impossible for you to do given your current level of expertise.   

Resources 
You may want to consult some of the following websites to get ideas for your proposal: 

Color scheme:  

 http://www.colorschemer.com/schemes/ 

 http://paletton.com/ 

 http://www.degraeve.com/color-palette/ 

 https://color.adobe.com/create/color-wheel/  
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Font selection: 

 https://www.google.com/fonts   

 http://www.w3schools.com/cssref/css_websafe_fonts.asp (This site has a good overview of the 
only “safe” web fonts to use without a third-party JavaScript.) 

User experience (if you need to keep mobile users in mind): 

 http://mobilewebbestpractices.com/resources  

Image use: 

You can find many images for use under Creative Commons licensing by using Flickr’s advanced search 
and selecting “Only search within Creative Commons-licensed content”: 
http://www.flickr.com/search/advanced/?q=g 

If your client is not a nonprofit organization, make sure to search for Creative Commons images that are 
licensed for commercial use (check the box “Find content to use commercially”). 

 

Make sure your proposal meets or exceeds the following assessment criteria: 

 The proposal contains a brief summary of the client’s business requirements and clearly explains 
how the proposal addresses these requirements. 

 The design mock-ups for the client’s home page are consistent with the look and feel that the 
client requires. 

 The overall visual design in the proposal fits the topic/theme, and the purpose, of the client's 
website. 

 The information design and site navigation described in the proposal will be clear and relevant to 
the users. 

 The proposed look and feel uses text and graphics that will appeal to the target audience. 

 The proposal accurately integrates the client’s functional and technical requirements into the 
design. 

 The proposed design prominently represents the client’s name, logo, important graphic images, 
and color scheme. 

 The proposal is neat, with correct spelling and grammar. 
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Student Resource 8.7 

Example: Look and Feel Proposal 

Client Name: David Lundholm 
Business Name: Fair Teacher Feedback 
URL (if known): www.fairteacherfeedback.com 
 
 

Business Requirements 

The proposed look and feel for Fair Teacher Feedback resembles a real student report card. The site 
contains photos of teachers and students as well as text that indicates how to use the site (“Students do 
the grading!” “Rate your teacher!”). Teachers and students will quickly understand that the purpose of the 
site is to provide teachers with honest and fair feedback from their students.  

 

Content Requirements 

The proposed look and feel for Fair Teacher Feedback uses bold, contrasting colors that represent the 
company’s current logo colors and that appeal to local and national high school students and teachers. 
The navigation has a school theme and is simple to understand and use to find the content or area the 
user may be looking for. Content will be provided by the client, and most content will be on the web pages 
(such as the registration instructions, sample teacher report cards, company history, and difference from 
similar sites). Some will be available as downloadable PDF files (such as a newsletter and FAQs). 

 

Functional Requirements 

The proposed look and feel for Fair Teacher Feedback indicates that students or teachers will need to 
register via a secure login area and will be granted different levels of access depending on their role 
(student, teacher, or administrator). The site will be highly secure, and after logging in, the user will see 
only his or her personal classroom and then be able to provide or read feedback. The site will use a star 
rating system and input fields similar to other social networking sites that the students are already familiar 
with. 

 

Technical Requirements 

The proposed look and feel for Fair Teacher Feedback will accommodate 300–500 visitors per month to 
start and then eventually 50,000+ users. Most users will be online in the afternoons and early evenings, 
especially at the end of grading periods after report cards come out. Site usage will be slowest during the 
summer. There will be little to no animation, video, or audio requirements. Site security will need to be 
high, with passwords that are at least six characters long and case sensitive. Basic registration 
functionality will be needed for new teachers to register and create an account. 
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Sample: Look and Feel Proposal—Design 1 
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Sample: Look and Feel Proposal—Design 2 
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AOIT Web Design  

Lesson 9 
Using Development Tools and 

Techniques 

Student Resources 

Resource Description  

Student Resource 9.1 Guide: Template-Designed Web Pages 

Student Resource 9.2 Tutorial: Preparing a Layout for a Template 

Student Resource 9.3 Tutorial: Creating a Template 

Student Resource 9.4 Tutorial: Creating Child Pages 

Student Resource 9.5 Tutorial: Updating a Template 

Student Resource 9.6 Tutorial: Creating Library Items 

Student Resource 9.7 File Management Structure: Organizing Your Website’s Files 

Student Resource 9.8 Assignment Sheet: Culminating Project Infrastructure 
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Student Resource 9.1 

Guide: Template-Designed Web Pages 

Directions: Look at the three template-designed web pages in this resource with your partner and think 
about which regions or sections of the pages appear on all pages and which are unique to only one of the 
pages.  

 

 

This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective owners. 
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This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective owners. 
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This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective owners. 
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Student Resource 9.2 

Tutorial: Preparing a Layout for a Template 

Directions: Follow the instructions in this tutorial to make final changes to the layout of your Sample Site 
Final so that you can convert it to a template for your sample site.  

When you last worked on your layout in Lesson 8, the top of the page and the footer area looked like this: 

 

 

To make this layout page more suitable for a template, you will make three changes: 

1. Replace the text in the content area with something more appropriate for a template, such as 
“Insert content here.” 

2. Replace the footer text with a copyright statement.  

3. Set up the sidebar area below the navigation menu so that you can place an image and a caption 
there. 

When you finish making these changes, your layout will look something like these screenshots: 
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Step 1: Insert Appropriate Placeholder Text in Content Area 

1. Make a backup copy of mylayout.html. Name it mylayout_backup.html, in case you need to start 
over again or you need it to create another template. 

2. Open Dreamweaver and open mylayout.html in Design view. You may also try using Split view to 
see the code changes that correlate with the changes you make. 

3. Triple-click to select the heading “Welcome to My Layout Page!” 

4. Type Insert Main Heading Here to replace the text.  

5. Select the remaining text in the content area. Type Insert content here to replace the text.  

6. Save the file. 

Step 2: Modify the Footer 

1. Be sure your mylayout.html file is still open in Design view. 

2. Select the placeholder text in the footer. Replace it with Copyright [year] [Your Name]. All rights 
reserved.  

3. Save the file. 

Step 3: Insert an Image Placeholder in the Sidebar 

1. With your mylayout.html file still open, switch to Code view. 

2. In the Sidebar <div>, find the two paragraphs of text that are located directly below the navigation 
menu. 

3. Delete the first paragraph (the longer one). 

4. Replace the second paragraph (that is, the text inside the opening and closing <p> tags) with 
Insert caption here. 

5. Place the cursor to the left of the opening paragraph tag. 

6. Select Insert > Image Objects > Image Placeholder. 
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The Image Placeholder dialog box appears. 

7. In the Image Placeholder dialog box, type Sidebar in the “Name” field. 

8. Type 180 in the “Width” field and 150 in the “Height” field. 

9. Leave the “Color” and “Alternate text” fields blank. 

 

10. Click OK. 

11. Switch to Design view. You should see an image placeholder in the sidebar area below the 
navigation menu, and your “Insert caption here” instruction below the image placeholder. 

 

12. Save the file. 
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Student Resource 9.3 

Tutorial: Creating a Template 

Directions: This tutorial guides you through the process of creating a template for your sample site, based 
on the layout you completed in the previous tutorial. Follow the specific instructions below. 

Step 1: Create a Template from an Existing Layout 
A template is a master page from which child pages are created. Most WYSIWYG editors, including 
Dreamweaver, provide the features you need to create a template.   

1. You will create your template from the My Layout page you modified in the previous tutorial. Be 
sure your mylayout.html file is stored in your Sample Site Final main (root) directory and that it is 
available for editing in Dreamweaver. 

2. Open Dreamweaver, and open your most recent version of mylayout.html. 

3. Select File > Save as Template. 

 

Dreamweaver always saves templates in a special directory called “templates.” When you created 
your Sample Site Final project, you created a directory by that name, so Dreamweaver will save 
the file there. Otherwise, Dreamweaver would create its own templates directory. 

4. When the Save As Template dialog box appears, be sure your sample site name is correct. Leave 
the Description field empty. Save the file as mytemplate. (DW will add the file extension .dwt.) 
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A dialog box appears asking if you want to update the links. 

Since the template is saved in a subfolder, updating the links in the code is necessary both now 
and when you create child pages later.  

The most important link currently in your new template is the one to your CSS file. If DW doesn’t 
update that link, your template will have no CSS styling. 

 

5. Click Yes to update the links.  

Dreamweaver saves your file in the templates directory as mytemplate.dwt. 

6. Open Windows Explorer (File Explorer) and check to be sure that your new template file is where it 
is supposed to be in the directory structure of your sample site.  

Step 2: Change the Title Text of the Template  
Dreamweaver treats almost all regions of a new template as part of the master design (and therefore 
currently locked and uneditable). The only region of a template-based page that is not locked by default is 
the title, since all pages in a site should have unique names. The first step is to change the title of the 
template file so that this text tells the person using the template what to do. 

1. Look at the current title of the new template page. 

 

2. Change the title to Insert Title Here. 

3. Save the template file. You will get a warning message that says: “This template doesn’t have any 
editable regions. Are you sure you want to continue?” Go ahead and click OK. (You will be 
creating editable regions in the next step.) 

Step 3: Designate Editable Regions in the Template File 
For regions of your template-based child pages that need to be unique (for example, the text in the 
content area), you need to designate them as editable. In this step, you will designate editable regions for 
two of the regions in your new template. 
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You will make the sidebar and content regions of your sample site editable, because both need to be 
unique for each page on the website. 

1. Click anywhere in the sidebar.  

2. In the tag selector area at the bottom of the workspace (see screenshot below), click 
<div.sidebar1>. 

 

Everything in the sidebar is selected. 

3. Choose Insert > Template Objects > Editable Region. 

 

4. Name the editable region SideContent. 
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5. Click OK. 

A blue tab appears at the top left of the sidebar with the label “SideContent.” 

 

6. Click anywhere in the content area, and then click <div.content> in the tag selector area to 
select the entire content division. 

7. Choose Insert > Template Objects > Editable Region.  

8. In the New Editable Region dialog box, type MainContent in the “Name” field. 

9. Click OK. 

The name appears in a blue tab above the area, identifying it as an editable region. 

You now have three editable regions: the title, which is editable by default, the sidebar <div>, and 
the content <div>. All other regions (for example, the header and footer) are locked, so those 
regions will all be identical to the ones in the template when you create child pages. 

The template is linked to your external CSS file, just as your layout page was. When you create 
child pages they will also be linked to your CSS file, so the styling for your entire site will be the 
same. 

10. Save your template and close it. 
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Student Resource 9.4 

Tutorial: Creating Child Pages 

Directions: In this tutorial, you will create sample child pages based on the template you created for your 
sample site. Follow the specific instructions below. 

When you create a child page from a template, only the content in the editable regions can be updated. 
Child pages inherit all the content and styling from the locked regions of their template page. 

In this tutorial, you will create the following child pages: 

 index.html 

 about_me.html 

 tips_techniques.html 

You already have pages with the same names in your sample site, but you can’t use them with your 
template, because they were created using plain HTML with no CSS styling, and they are not child pages 
of the template page you just created. You may have thought you could simply attach them to the new 
template after the fact, but that is difficult to do in Dreamweaver. Instead, you need to create three new 
child pages with the same names as the originals, and then copy and paste the content from the originals 
to the new child pages. 

Step 1: Rename Your Original Pages 
You should already have an index.html page in your Sample Site Final root directory. You should also 
have an about_me.html page and a tips_techniques.html page in your Sample Site Final web_pages 
directory. Rename your existing pages to indexOLD.html, about_meOLD.html, and 
tips_techniquesOLD.html. 

Step 2: Create a New Home Page 

1. Open Dreamweaver, and then open indexOLD.html. 

2. With indexOLD.html still open in Dreamweaver, select File > New. 

3. In the New Document dialog box, select the “Page from Template” option.  

Be sure the Site list is pointing to your Sample Site Final directory. 

Be sure the Template list is pointing to mytemplate, the DWT file you created. 

Be sure the “Update page when template changes” checkbox is checked. (If you make changes to 
the template later on, you want to be sure your existing pages will reflect those changes.)  
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4. Click Create. 

Dreamweaver creates a new page called Untitled-1 that looks exactly like your template at this 
point. 

5. Change the title by typing Home in the Title field. 

 

6. Save the file in your root directory as index.html. 

7. Look in the upper-right corner of the workspace area, and notice that your new child page 
identifies the template it is based on in a yellow label that reads “Template:mytemplate.”  
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8. Move your cursor around the screen. Notice that the locked cursor symbol appears when the 
cursor is hovering over a locked region. 

 

9. Keeping your new page open, move to your indexOLD.html page. 

10. Select the heading and the paragraph, and copy them. 

 

11. Move back to your new child page and paste the heading and text in place of the placeholder 
heading and text in the content area. 

Your new home page should now look like the following screenshot. 

 

Although the sidebar is editable, we aren’t going to make any changes to it now. 

12. Close indexOLD.html. 

13. Save the changes to index.html. 

Step 3: Create a New About Me Page 

1. Open about_meOLD.html in Dreamweaver. 

2. With about_meOLD.html still open, select File > New. 

3. Create a new child page using the same options you did when you created index.html. 

4. Title your new page About Me. 

5. Copy the content (text and images) from about_meOLD.html to about_me.html. 

If you have images but you haven’t yet moved them over to your Sample Site Final directory 
structure, do that now. Be sure to put them in the images directory. 
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If you are in Design view, the Image Description (Alt Text) dialog box appears and instructs you to 
enter a description for each of the images. Enter alt text for each image, in the Description column. 

6. Close about_meOLD.html. 

7. Save the new file in the web_pages directory as about_me.html. 

Your new About Me page should look something like the following screenshot. 

 

Step 4: Create a New Tips and Techniques Page 

1. Open tips_techniquesOLD.html in Dreamweaver. 

2. With tips_techniquesOLD.html still open, select File > New. 

3. Create a new child page using the same options you did when you created index.html and 
about_me.html. 

4. Name your new file Tips and Techniques. 

5. Copy the text from tips_techniquesOLD.html to tips_techniques.html. 

6. Close tips_techniquesOLD.html. 

7. Save the new file in the web_pages directory as tips_techniques.html. 

Your new Tips and Techniques page should look something like the following screenshot. 
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Student Resource 9.5 

Tutorial: Updating a Template 

Directions: Follow the specific instructions below. 

When a Dreamweaver template is modified, the locked regions of child pages made from the template will 
reflect the changes made to the template.  

In this tutorial, you will modify the vertical menu on the left of your current template (mytemplate.dwt) and 
then see how the changes made to your template affect the child pages you created. 

Step 1: Open the Template for Editing 

1. Open Dreamweaver and select Window > Assets. 

 

The Assets panel appears. It is usually grouped with the Files panel on the right side of the 
screen. 

2. In the Assets panel, click the Template icon. Your My Template file should appear in the list. If it 
does not, click the refresh button in the bottom-right corner of the panel. 
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3. Right-click mytemplate and select Edit from the context menu. 

 

The template opens. 

Step 2: Change the Template 

1. Select the text Home in the horizontal menu in the header. Change it to My Home Page. 

Because this area is a locked part of the template, all the child pages should reflect this change 
when they are updated. 

2. Select the text Tips and Techniques in the vertical menu in the sidebar. Change it to Important 
Information. 

Because the sidebar is in an editable region, the child pages should not reflect this change when 
they are updated. 

3. Change every instance of the word insert to add. (There are four instances, including the page 
title.) 

Do you expect these template changes to be reflected in the child pages, or not? Think about your 
answer as you observe the update behavior in Dreamweaver, next. 

4. Save the template file. 

The Update Template Files dialog box appears. 
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5. Click the Update button. 

The Update Pages dialog box appears. The log window at the bottom of the dialog box (Check 
“Show log” if you cannot see it) tells you which files were successfully updated and which were 
not. Your pages should have all updated. 

 

6. Close the Update Pages dialog box. 

Step 3: See How Template Changes Affect the Child Pages 

1. Leave the My Template file open and open Tips and Techniques. 

As you can see, the name in the horizontal menu has changed to My Home Page (because it is in 
a locked region), but the name in the vertical menu has not (because it is in an editable region).  

2. Check the state of the other two pages: Home and About Me. Their changes should be the same 
as the changes to Tips and Techniques. 

3. Close all open files, and also close Dreamweaver. 
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Student Resource 9.6 

Tutorial: Creating Library items 

Directions: In this tutorial, you will learn how to create a library item, which is a chunk of HTML code that 
you plan to use often on your site. Follow the instructions below to create a library item for Sample Site 
Final. 

The mytemplate.dwt file for your sample site still has one potential problem: the vertical (sidebar) menu is 
in an editable region. If you want that menu, with identical links, to appear on several pages of the site, it 
should not be in an editable region. 

To fix the problem, we will replace the vertical menu with a dynamic content element called a library item. 
Library items are reusable chunks of HTML that you use frequently within a website. They behave 
similarly to a template. When you make changes to a library item, Dreamweaver automatically updates 
every page that uses that library item. 

Step 1: Create a Library Item 

1. Open Dreamweaver and, just as you did in the tutorial where you updated your template, open 
mytemplate.dwt from the Assets panel. 

2. Insert the cursor in the vertical menu. Click the <ul.nav> tag selector. 

 

3. Go to the Assets panel (choose Window > Assets to display the panel, if necessary). 

4. Click the Library category icon (the open book icon). No library item should be visible yet. 
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5. Click the New Library Item icon at the bottom of the panel. A dialog box appears with a warning 
message. 

 

6. Click OK. 

7. Type vertical-nav in the library item name field, and then press Enter. 

Dreamweaver creates a library item from the selected menu code and replaces the existing menu 
with the library item code. Dreamweaver also creates a Library folder in your site’s root directory 
and inserts the library item. 

8. Save the template and update linked files. 

9. Look at the Update Pages report. 

If your report indicates that your child pages were not updated (as does the following report), you 
will need to update the child pages by hand. 

 

10. Open all three child pages (index.html, about_me.html, and tips_techniques.html). 

11. Starting with index.html, click in the left navigation area, and then click the <ul.nav> tag selector. 

12. In the Assets panel, select the vertical-nav item in the Library category. Click the Insert 
button. 
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13. The <ul.nav> in the index.html file is replaced by <mm.libitem>.  

14. Position the cursor over the vertical menu in the sidebar. Notice that the locked icon appears, 
indicating that the navigation bar is not editable. 

15. Switch to Code view and find the code for the new library item. Notice that it is highlighted with a 
different color than the surrounding area and that it contains special markup code. 

Be aware that although library items are locked in Design view, they can be edited in Code view.  

16. Right-click vertical-nav in the Library list and select Update Site from the context menu. 

 

The Update Pages dialog box appears. 

17. Click Start. The status report shows which pages were examined and updated. 
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18. Click Close to exit the dialog box. 

Dreamweaver updates and resaves all unopened files. You need to manually save any files you 
have open, which in this case is index.html.  

19. Save index.html. 

Step 2: Update a Library Item 

1. In the Library category list in the Assets panel, double-click the vertical-nav item. 

2. Switch to Code view. 

3. Change the “Important Information” link back to “Tips and Techniques.” 

4. Save the library item file. 

Your three child pages and your template should update. 

5. Open the four pages and check to be sure they all contain the updated library item, with the top 
menu item showing link text of “Tips and Techniques.” 

6. Close all files, and close Dreamweaver. 
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Student Resource 9.7 

File Management Structure:  
Organizing Your Website’s Files 

Student Name:_______________________________________________ Date:___________ 

Directions: Organizing the pages and files within your website is critical to the functionality of your site. 
Use this worksheet to sketch out the structure of your website in the sidebar at right. Your sketch should 
show all of the folders that you plan to use for your website, and it should list all web pages you will have 
under the appropriate folder. 

1. Begin your sketch with a main site folder for 
your site. Make sure to give the folder an 
appropriate name. This folder will contain your 
index.html file (your home page) and 
subfolders for the web pages and graphics 
that you will place on your site. 

2. Using your site map as a guide, organize and 
create a subfolder structure. You need a 
subfolder to contain your web pages and 
another subfolder to contain graphics. If your 
site has multimedia, you will need a 
multimedia folder also. 

3. Decide on naming conventions to use for your 
web pages and graphics, based on the best 
practices listed in this resource. 

4. Under your folder for web pages, write down 
the file name for each page in your site map. 
You will create the pages after you have 
created your template; right now you need to 
write down the file name of each page you will 
create. Remember to follow your naming 
conventions. 

5. Write down the names of any graphics that 
you already have, such as your logo, in the 
graphics folder. Remember to follow your 
naming conventions. 

6. When you have completed your sketch, open 
Windows Explorer (File Explorer) and create 
your folder structure. Add any graphics or 
multimedia files that you have to the 
appropriate folders. Do not create your web 
pages here. You will create the web pages in 
Dreamweaver using your template. 
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Naming Conventions 
Use the following guidelines for naming your files and folders. Professional web designers consider these 
guidelines to be best practice. 

 All file and folder names should be lowercase and without spaces. 

 Ideally, folder names should be the shortest English word that communicates the content, or two 
English words smashed together to do the same. For example, “about” is a better folder name 
than “aboutus.” Note that you can still title your web page whatever you want. 

 It is good practice to name images relatively obscurely so that they don’t interfere with desired 
URL names for pages.  

 

Make sure your file management structure meets the following assessment criteria: 

 The main site folder (the root folder) contains all other folders and files. 

 The hierarchy of pages, graphics, and files is appropriate and organized. 

 All folders and files follow a consistent, proper naming convention. 

 All pages in the site map are represented. 

 The home page sits at the top level of the file structure and is in the root folder. 
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Student Resource 9.8 

Assignment Sheet: Culminating Project Infrastructure 

Directions: Follow the steps below to create a layout, a template, child pages, and at least one library item 
for your culminating project website. Be sure to read the entire assignment sheet before you begin work. 
Also, study the rubric your teacher gives you, and make sure you know how your work will be assessed. 

Step 1: Create the Layout for Your Culminating Project Site 
Use Dreamweaver to create a layout page of your culminating project site, based on the wireframe and 
the look and feel proposal you created for your client. The layout page you create for your culminating 
project site will be similar to the mylayout.html page you created for your sample site. When you complete 
your layout page, you will convert your layout page to a template. Follow the instructions below to create 
your layout page.  

1. Open your mylayout.html page from your sample site in Dreamweaver so that you can use it as a 
model page as you create your client’s layout page.  

2. Use the same DW layout as your mylayout.html page, or choose another that you think is more 
suitable. 

3. Name your page Client Proposal Home. 

4. Save it in the root directory of your project website directory. 

5. Remove the placeholder text in the content area of your new DW layout page, and type in 
appropriate text. 

6. Remove the placeholder text in the footer of your DW layout page, and type in an appropriate 
copyright statement. 

7. Insert your client’s logo in the logo block, just as you did in mylayout.html.   

8. Remove the placeholder text in the sidebar of your DW layout page, and replace it with any text or 
graphics you want to include in your proposal page. 

9. Move the CSS style information from your layout page to a separate CSS file. 

 

Tips: 

 Make sure each region of your layout page is a separate <div>. 

 Think about which regions will be locked and which regions will be editable. Add the correct 
content (such as logo and menu items) to the regions that will be locked. These will form the basis 
of your template. 

Step 2: Create Your Template 
Use Dreamweaver to create a template (DWT file) from your layout page. Use the same procedure you 
used to create a template for your sample site. 
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After you create your template, check to make sure that each <div> that should be locked is locked and 
each <div> that should be editable is editable. Also make sure that your template is linked to your CSS 
file. 

When you save your template, don’t forget to adhere to the file structure that you created for your site.  

Step 3: Create Child Pages 
When you are satisfied that your template is correct, create child pages for your website, following the 
same procedure you used to create child pages for your sample site. Look at your site map to see what 
child pages you will need.  

1. Create a child page for each page on your site map. Make sure that each child page is created 
from the template and that each has the correct editable and locked regions on it. 

2. You will fill in the editable content for these pages in future lessons. Right now you can leave all of 
the editable regions blank.  

3. Save the child pages in the correct directory for your site.  

4. If you find anything in the template that needs to be revised to make your child pages work 
correctly, update your template. Then check the child pages to make sure they work correctly. 

Step 4: Add at Least One Library Item 
Take a close look at all of your child pages and figure out how at least one library item would enhance the 
way your website works. Create the library item following the same procedure you used to create a library 
item for your sample site, and use the library item in the appropriate region of your pages.  

Step 5: Test Your Work 
Have all members of your group test your pages against the following checklist to make sure they work 
correctly, and then make any necessary revisions: 

 There is an index.html page for the home page of your site. 

 The template is linked to a CSS file. 

 There is a child page for every page indicated in the site map. 

 All child pages are connected to the template. 

 All pages are named correctly and in the correct folder in the site directory. 

 All pages open correctly and display the correct information on the correct part of the page. 

 All menus work correctly. 

 All library items work correctly. 

 All spelling and grammar is correct. 

 

Make sure that your site infrastructure meets all criteria on the rubric before you submit it for assessment. 
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Student Resource 10.3 Note Taking: Preparing Images for the Web 

Student Resource 10.4 Checklist: Preparing Your Client’s Website 
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Student Resource 10.1 

Web Writing: Adapting Content for the Web 

Directions: Westside Pizza knows a lot about pizza, but it doesn’t know much about writing web content. 
Working with a partner, take the paragraphs below about Westside Pizza and adapt them for the home 
page of the company’s website. Use a page in your notebook or a blank sheet of paper to sketch out the 
content of the home page. Remember, on a website, people need to be able to find what they’re looking 
for quickly, and what they see needs to appeal to them. You don’t have to include all of this information 
on the home page (you probably want to just add links to some of it). Also, Westside may have forgotten 
some important content that it needs on its home page. If you decide to use images or infographics for 
some content, just make a very quick sketch, or just say what the picture will show. 

Westside Pizza is your best shot for great Italian food. We serve lunch, dinner, and takeout. We have 
starters, salads, pastas, pizzas, calzones, sandwiches, strombolis, and desserts. All meals for kids are 
under $5 and include dessert. 

Everything is fresh. Pasta comes with garlic bread. Salads have only the finest fresh ingredients, and they 
come with garlic bread too. Sandwiches come with a choice of fries or salad. There are tons of choices of 
meats and cheeses, hot or cold. Calzones are our specialty. The dough is filled with meat, vegetables, 
mozzarella, and parmesan cheese. Do you know what a stromboli is? It’s named after a volcano in Italy 
because it erupts with flavor. It’s pizza dough wrapped up like a volcano with incredible fillings. We’ve 
been known for our pizzas for over 25 years. You can get most any kind you want. And don’t forget that 
our desserts are big enough to share. 

Come visit us: 510 38th Street, Falling Oaks, Virginia (just across from the library). 
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Student Resource 10.2 

Examples: Effective Writing for the Web 

Student Name:_______________________________________________ Date:___________ 

Directions: The examples in this resource illustrate the rules of good writing for the web. Study each rule 
and the example that illustrates it, and then answer the questions about each example. 

Writing for the web is quite different from writing for print media such as a magazine, a brochure, or a 
book. Your job as a web designer is to make it easy for your website’s users to understand the goal of the 
website and find information. When people have a pleasant experience and quickly understand what a 
website can provide them, they will feel comfortable and return to the site. Organized content and 
effective writing is essential to that positive user experience. 

Make Sure Your Content Is Accurate 
All content must be up-to-date, accurate, and not offensive. Write text in a consistent tone, with no 
grammatical or spelling errors. 

 
This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective owners. 

 

How can you tell these articles on Yahoo! News are up-to-date? 
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Use Large Headlines with Smaller Subheads 
Content should be placed in a clear hierarchy with the most important information being the most 
prominent. Headings can then link to more information or a complete article. If something catches a 
user’s eye, he or she can click deeper to learn more. 

 

 
This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective owners. 

 

Notice how the top news stories of the day are presented in larger text, with supporting articles listed 
under them in slightly smaller text? Choosing text sizes in this way helps readers figure out right away (1) 
what is making news right then, and (2) what else, while also interesting and important, is not as “big” a 
story. 

What seems to be the “biggest” news story on the page above?  
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Design Content for Scanning 
Text should be easily readable and “scannable”—short sentences, short paragraphs, and bulleted lists 
wherever possible. People are in a hurry; they want to find exactly what they are looking for quickly. They 
want to be able to scan the first reasonable option to see if a site has what matches their interests, and if 
not, try the next immediately. 

 
This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective owners. 

Notice how this article uses many short paragraphs, and each paragraph tells a reader a complete 
thought. Readers can easily get the basic facts of the story and move on, if they choose, without having 
to read the entire article to learn what has happened to Monta Ellis. 

Can you think of a more effective way to deliver the most important information in the sentences 
below about Michael Jordan?  

Michael Jordan, a basketball player from North Carolina and father of four, loves basketball. He 
played for the Chicago Bulls and received 14 MVP awards, which is a record. 
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Use Descriptive Titles and Keywords 
Keep the content searchable: use important keywords in the title tag and repeat them throughout the 
copy, without sounding unnatural. Search engines pick up keywords and display titles, so these should be 
written to encourage people to go to your site. 

 

 
This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective owners. 

In this story, writers have repeated the words Bermuda and Bertha many times. This will help a search 
engine to find the article and “understand” that the article gives information about Hurricane Bertha, which 
is off the coast of Bermuda. 

Circle each time Bermuda is mentioned, and underline each time Bertha is mentioned.  
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Make Your Writing Concise 
Users do not have time to read on the web, so they prefer when writing gets right to the point. Cut out 
flowery, descriptive language, omit words wherever possible, keep instructions short, and do not repeat 
yourself. Read the text out loud to listen for awkward phrasing, repeated thoughts, and ways sentences 
can be pruned. 

 
This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective owners. 

This article, which tells how animal camouflage works, does a great job of putting the information into 
short, concise sentences. 

Underline two or three sentences in the article that you think are particularly good web writing. 
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Give Summaries First 
Start your copy with a short summary, then elaborate, and then summarize again. Readers who are 
scanning the text should be able to get the gist of your message in the first paragraph. If you put the most 
important part at the end, they may not read all the way through to get to it. 

 

 
This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective owners. 

 

Though the article above goes into great detail, it starts with a good summary of what the article is about, 
why it is being written, and why a reader would want to keep reading. 

From these four short sentences, tell exactly what you expect to find in this article. 
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Know Your Audience 
Content should reflect what target users of the site will find valuable and be written in a way to hold their 
attention. Answer the questions below to examine how message targeting affects writing. 

 

From American Girl: 

 

 

This image included under fair-use guidelines of Title 17, U.S. Code. Copyrights belong to respective owners. 

 

Who is this page designed for?  

Give at least five clues that tell you who the intended audience is.  
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Use Obvious Buttons and Links 
Make it easy for users to get to their desired destination by making new and visited links obvious through 
color. Make button descriptions short but clear. 

 
This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective owners. 

 

Look at the color used for links on this page. List the names of the links the user has clicked on: 
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Chunked Content  
Organize your content into logical categories or “chunks.” Standalone blocks of two to three sentences 
are more easily scanned and require less scrolling. Long paragraphs are hard to read on a computer 
monitor. 

 

 

This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective owners. 

 

What “chunks” of content can you see here? 

  



AOIT Web Design  
Lesson 10 Gathering and Preparing Web Content 

Copyright © 2008–2015 National Academy Foundation. All rights reserved. 

 

Adapting Content for a Mobile Website 
At some point, you may need to adapt a website for viewing on a mobile phone. On a mobile website, all 
of the content must be useful. In general, mobile content should be more actionable and focused on user 
needs. It should be fast, highly readable, and easy to navigate. As an overall rule, give a summary 
paragraph with bulleted key points and a link to the full text. To favor search engine optimization (SEO), 
focus on descriptive titles rather than clever ones. Remember that mobile users are dependent on search.   
 

  
This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective owners. 

 

What makes this web page look different from a web page that is not adapted for mobile? 
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Student Resource 10.3 

Note Taking: Preparing Images for the Web 

Student Name:_______________________________________________ Date:___________ 

Directions: Answer the following questions as your teacher demonstrates how to prepare images for the 
web. 

1. Which type of image will we use in our client’s website: raster-based or vector-based? 
 
 
 
 

2. Where can we obtain photos or clip art for our site? 
 
 
 
 

3. What are some ways we can use our own artwork or photos for our website? 
 
 
 
 

4. What are some guidelines for adhering to image copyright laws? 
 
 
 
 

5. Where on our client site will we use inline images? Will we use web graphics in any other way? 
 
 
 
 

6. Are any of our graphics photos? Which format should we use: JPEG, GIF, or PNG? 
 
 

 
 

7. Do any of our graphics require transparency? Which format can we use—JPEG, GIF, or PNG—
and how do we create transparency? 
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8. Describe the difference between the file size and the physical size of an image. What is the 
recommended file size maximum for web graphics? What is the recommended overall file size for 
a web page, including all of the images and the web page file itself?  
 
 
 
 

9. What is the standard resolution (pixels per inch) for our web graphics?  
 
 
 
 
 

10. Should our web graphics be in CMYK or RGB color model?  
 
 
 
 
 

11. Why is using height and width attributes to resize an image in HTML not a good idea? How will we 
resize our images? 
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Student Resource 10.4 

Checklist: Preparing Your Client’s Website 

You have mapped out the scope of the content for your website in your site map. You know where each 
type of content will reside on the pages per your wireframes, and you have sample pages created from 
your template. Now you need to fill in the blanks by creating and placing content onto your web pages. 
Your client may already have content for you to use—a brochure, a marketing packet, or a newsletter, for 
instance—but you will still need to turn that material into content for the web. 

As you create your web content, first write all the text in each section of the page using Dreamweaver in 
Design view. Then assign the content to headers and apply boldface, italics, colors, and list formatting. 
Remember to read your text out loud, and then make any final modifications.  

Make sure your materials meet or exceed the following assessment criteria: 

Written Content Criteria: 

 All content is complete, accurate, up-to-date, and grammatically correct; has no spelling errors; 
and is written in a tone appropriate for the audience. 

 Content is written and categorized logically and has appropriate hierarchies and 
headlines/subheads. 

 Text is written for scanning, with short paragraphs, bulleted lists, concise text, and up-front 
summaries.  

 Links and visited links are made obvious through color. 

 Descriptive titles and keywords are used throughout the text. 

 

Graphical Content Criteria: 

 All graphics are raster-based RGB images at 72 ppi, and all contain useful <alt> attributes. All 
images combined for the web page are no larger than 144K, unless there is an exceptional reason 
the combined images are larger, such as an image gallery page. 

 All graphics are obtained legally and are used tastefully and consistently within the site’s visual 
design and color scheme. 

 Photos are in JPEG format, and logos, banners, and other simple graphics are in PNG or GIF 
format.  

 Transparent images are created without a halo. 

 Images are fully optimized, no height and width tags are used to resize images, and images that 
link to other pages or documents are coded correctly. 

 All image files follow the site’s naming convention and are placed properly within the directory 
structure. 
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Lesson 11 
Preparing a Website for Launch 

Student Resources 

Resource Description  

Student Resource 11.1 Characteristics Chart: Usability and Accessibility  

Student Resource 11.2 Test Log: Usability and Accessibility  

Student Resource 11.3 Reading: User Testing 

Student Resource 11.4 Guide: User Testing Plan 
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Student Resource 11.1 

Characteristics Chart: Usability and Accessibility  

Student Name:_______________________________________________ Date:___________ 

Directions: Follow your teacher’s instructions to categorize the features that make a website easy to use 
as “usability” or “accessibility.” A couple of samples for each are provided to get you started.  

Usability Accessibility  

All buttons and links work and navigate to the 
correct place.  

All text is accurate and grammatically correct. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fonts are readable, high-contrast, and stationary. 

All color information can be converted into black 
and white and still be understood. 
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Student Resource 11.2 

Test Log: Usability and Accessibility  

Student Names:______________________________________________________________________ Date:_____________________ 

Directions: First, work with your group to decide how you will complete each of the following testing tasks for your culminating project website and 
record your answer in the second column. Next, assign each member of your group to a specific task. Each group member should then complete 
a thorough usability test and, in the Errors Found column, report any errors or problems. Finally, make appropriate fixes or modifications to your 
site and report your changes in the last column. Review the assessment criteria at the end of this resource before you begin work.  

Testing Task How It Will Be Tested Errors Found How Errors Were Fixed 

Links: Every link is 
functional and navigates to 
the proper location. 

 

   

Text: All text is accurate, 
spelled correctly, and 
grammatically correct. 

 

 

 

 

  

Images: All images appear, 
are aligned properly, and 
contain <alt> attributes in 
the <img> tags. 

 

 

 

 

  

Browser compatibility: Site 
validated on many platforms, 
browser types, versions, and 
connection speeds. 
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Testing Task How It Will Be Tested Errors Found How Errors Were Fixed 

Accessibility: Code 
adheres to as many Section 
508 guidelines as is 
appropriate (for example, 
site map, <alt> attributes, 
page titles, link titles).  

 
 

  

Directory structure: 
Directory structure is 
organized and used 
efficiently; unused files are 
deleted. 

   

Navigation: Navigation is 
consistent and well 
organized and makes sense 
to end users. 

   

Tables: Tables contain a 
caption. Sample: 

<table> 
<caption>Shopping 
List</caption> 
<tr><td>...</td></t
r> </table>  

   

 

Make sure your usability and accessibility test meets or exceeds the following assessment criteria:  

 There is a clear description of how each item will be tested. 

 A thorough usability test is completed for each item, and all errors found are recorded. 

 All site modifications are properly recorded in the test log. 

 The resulting website includes all the necessary changes and bug fixes; proper version control is maintained during testing. 
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Student Resource 11.3 

Reading: User Testing 

Your site may seem to work perfectly for you, but will it work for your actual users? As a website designer, 
you have now become so familiar with your site that there may be issues you don’t notice or would not 
even think to look for or improve. If you want a good website, you must first conduct user testing before 
launching your site to the public. User testing involves sitting people down to actually try your site and 
observing how easily they can use the site to complete tasks or find information, and if they find it 
appealing. Without user testing, you won’t know if your site has problems or if your users will have a 
positive experience.  

Formulating a testing plan is the first step in user testing. A plan will help you identify your testing goals, 
audience, methodology, recording mechanism, and means of evaluating and using the results. 

Ideally, you would recruit at least 7–10 testers who represent your target audience. The more people and 
the more varied the people you recruit to test the site, the more information you will get and the more 
accurate your results will be. When a problem or an opinion is repeated, it has more weight because 
personal bias and skill are minimized. But remember, a large, targeted audience can be difficult to find in 
a short amount of time, and testing with even one user from any segment is better than no testing at all! 

User testing may need to be extremely formal and scientific for a large company with a large complex 
site, but a simple site may need only a small-scale, informal test. Testing on a working prototype is best, 
as you want your users to see and experience a basic working site. You should attempt to test your site 
over a web connection by publishing your site to a test server. This will be the most accurate test you can 
do, because it is most representative of the response time your users will experience. If publishing your 
site to a server is not an option, testing locally on a hard drive is also acceptable, but keep in mind that 
the user experience will be faster than it will be on the final site. Think about the range of platforms, 
browsers, and connection speeds you are able to test. The more browser compatibility checks you can 
do, the more you can validate your site’s functionality. And there are tools online that can analyze website 
accessibility, like the WAVE accessibility tool (http://wave.webaim.org/). 

Recording your test results is critical for when you later evaluate the data and modify the website 
accordingly. Determine in advance if you will record your test observations via notes or video, but 
remember that videotaping can be intimidating to some people, and a release form is usually needed. 
Always remind testers that it is the site that is being tested, not them. Also, plan ahead for how you will 
compensate or thank your testers. 

Your testing plan should contain the method you will use to instruct testers to use the site. One efficient 
method is a task-oriented test, where you instruct people to complete specific tasks on the site. (For 
example, “Locate the...,” “Find and read the...,” etc.) Create a list of two to five appropriate tasks for your 
site, and then observe how your testers complete those tasks. Ask questions as they proceed through the 
tasks and/or create a questionnaire for testers to complete after they are finished. Rating questions work 
well on questionnaires. For example, “With 1 being easy and 10 being difficult, how easy was the site to 
use?” or “Rate the graphics and color scheme of the site” or “How likely are you to return to the site?” 
Also provide opportunities for open-ended commentary (e.g., “What did you like about the site?” or “What 
would you change about the site?” or “Do you have any other comments or suggestions?”). 

Review your results right after the test and add any other notes that come to mind. Think about how you 
will summarize and most efficiently use the results to improve your site; options include a table, a report, a 
chart, or another tool.  

Remember, user testing should not be considered an extra, or a luxury only done if time and money 
permit. It is a critical component of the web design process. Use the list in Student Resource 11.4, Guide: 
User Testing Plan, to help formulate your own user testing plan. 
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Student Resource 11.4 

Guide: User Testing Plan 

Directions: Working with your group, use the following guide to write a user testing plan for your client’s 
website. Write or type your test plan on a separate sheet of paper, using the format shown in the 
headings and bullets in this resource. Before you begin work, review the assessment criteria so that you 
are clear on how your teacher will assess your plan. 

Testing Goals: 

 What are the goals of your user testing? 

 

Target and Number of Users: 

 Will your users be within a specific age range? 

 Will your users be a specific gender? 

 Will your users be within a specific job type? 

 Will your users have a particular level of technology skills? 

 How many testers will you recruit to test your site? 

 

Testing Method: 

 Will you use a task-oriented approach? If so, what tasks will you assign the testers? 

 How will testers access the site? 

 What platforms, browsers, and connection types will you test with users? 

 How will you record the test: notes, video, other?  

 Is a signed release needed? 

 How will you compensate and/or thank your testers? 

 

Recording the Test: 

 Who will observe the test, who will take notes, and who will answer user questions? 

 Will you create a written questionnaire for users? If so, what questions will you ask? 

 How will you record bugs such as missing images, errors, broken links, or spelling errors? 

 How will you record where users got stuck, struggled, or needed your help? 

 What else will you record during this test?  

 

Evaluation and Revision: 

 Will you create a report summarizing your test results? 

 How will you integrate the test results into your site? 
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Make sure your user testing plan meets or exceeds the following assessment criteria: 

 The user testing plan identifies clear goals for testing the site. 

 The user testing plan defines the proposed number of testers and includes a detailed and 
accurate description of the target audience’s age range, gender, job type, and technology skill. 

 The user testing plan contains clear descriptions of the testing method; the ways that testers will 
access the site; the computer platforms, browsers, and connection types to be used; the method 
for recording the test; and the plan for compensating the testers. 

 The user testing plan clearly explains how you will observe the test, how you will record 
information, and what information you will record. 

 The user testing plan explains how you will summarize the test results and how you will integrate 
the results into the website. 
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Student Resource 12.1 

Reading: Hosting a Website 

 

This presentation is intended to help students understand the role web hosting plays in designing a 
website, and the typical services most hosting companies provide.    
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Publishing your site to a live web server is the final step to actually seeing your hard work in web design 
on the World Wide Web. 
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If you want other people to view your website, you must first publish your site to a web server. This is best 
done by purchasing space on the servers of a web hosting company.  

Even though you could set up your own Internet-connected PC as a web server, it is more common, 
much easier, and much safer to use a web hosting service to store your web pages on its public web 
servers. Paying a professional web hosting service is the only reasonable solution for the vast majority of 
people and companies. Unless you have the necessary training to run a web server and can do the job 
full time, you need a web hosting service to avoid being hacked almost instantly.  

• Your ISP (Internet service provider) or your school’s ISP may have a web hosting service. 

• Free web hosting may also be an option, but it usually involves advertising and limited services 
and therefore may not be worth it.  

•  A blog service is a good way to publish personal pages but may not be appropriate for a 
company website. It may not allow you a custom domain name or unlimited design options. 

This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective 
owners. 
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Choosing a web hosting service is an important decision. Once you choose a service that meets your 
needs and your budget, you register your domain name with the web hosting service, and then you 
upload your web pages to its server. 

This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective 
owners. 
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The right web host for your client depends on services needed and on budget. Use this list of questions to research 
possible hosting packages and costs. 

Internet connectivity: Can the same host also supply your Internet connection? Will a packaged service save you 
money? 

Domain name: Have you picked a domain name? Can the host register the domain for you or your client? 

Web space: How much does your content directory need? How much will the site grow? Is there a need for email 
storage? (If the client will use IMAP email and store all email on the server, a year’s worth of email could use up a 
gigabyte of storage space.) 

Bandwidth: How much traffic do you expect and how much information can the web host deliver? As your traffic 
increases, can the host handle it?   

Email addresses: How many addresses with the same domain name are needed? (You certainly won’t need 1,000, 
but it might be useful to have 10.) 

Database: Does the site need to obtain and store basic contact info for clients (e.g., name and email)? In the 
professional world, this is a critical item. 

Advanced server features: Does your web host offer advanced server features such as server-side scripts like PHP 
or .NET (needed to process information provided on a website) or page encryption (SSL and HTTPS for secure 
connections to your website)? Does it offer the version of the server-side scripts that you have used or will be using to 
build your website? Most hosts will either be all IIS (Microsoft and .NET) or all Linux (Apache and PHP) or give you a 
choice. On a flat HTML site, it doesn’t make a lot of difference, but when it comes time to install server-side scripting, 
it will make a difference.  
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Just as you considered your client’s needs for services when selecting a web host for your client, 
consider the support required and the budget allotted for them. Use this list of questions to research 
possible packages and costs. 

Website statistics: Some hosting services track site usage and analyze traffic patterns that show how 
often people come to the site and where they go. But it is better to use a third-party service such as 
Google Analytics for this. 

Technical support: Does the host provide 24/7 access and 24/7 technical support? Does it have 
redundancy—that is, multiple locations in case one server location goes down temporarily? Does it offer 
24/7 phone support? Generally, more support is often worth paying for.  

FTP access for uploading: Does the host provide FTP access to upload and manage the content on the 
web server? If it provides a custom web application to manage content, will it be easy to use? Does the 
host offer multiple FTP logins? A lack of FTP support should probably rule out any host.  

Development tools: Does your client want any site development tools so that it can upgrade or revise 
the site in the future? What tools does the host provide? Can you install any tools you need that are not 
provided by the host? 

Control panel: Hosts always have a web interface that you use to manage your account. Is it easy to 
use? Does it give you access to the things you need? A poorly designed control panel can be very 
frustrating. 

Web host history: How long has the host been in business? What is its track record? Search the web for 
reviews. Longevity is a good sign. 
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There are hundreds of different web hosting companies. Here are a few popular sites to begin your 
research.  

This image included under fair-use guidelines of Title 17, US Code. Copyrights belong to respective 
owners. 
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Student Resource 12.2 

Checklist: Determining Your Web Hosting Needs 

Student Name:_______________________________________________ Date:___________ 

Directions: Take notes during your teacher’s presentation of Hosting a Website. Then work with your 
group to list your client’s needs for each of the typical hosting options. (Look for the information you need 
about your client on your Client Intake Form from Lesson 6.) 

Web Hosting 
Options 

Notes Client Needs 

Internet 
connectivity 

 

  

Domain name 

 

 

 

  

Web space 

 

 

 

  

Bandwidth 

 

 

 

 

  

Email 
addresses 
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Web Hosting 
Options 

Notes Client Needs 

Features such 
as server-side 
scripts and 
page 
encryption 

 

  

Website 
statistics 

 

 

 

  

Technical 
support 

 

 

 

  

FTP access for 
uploading 

 

 

 

  

Development 
tools  

 

 

 

  

Web host 
control panel 

 

  

Web host 
reputation and 
history 
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Student Resource 12.3 

Worksheet: Optimizing Your Website 

Student Name:_______________________________________________ Date:___________ 

Directions: Your teacher will assign you one of the following websites to analyze for optimization. Follow 
the steps below to analyze the site assigned to you.

www.apple.com 

www.amazon.com 

www.rhapsody.com  

www.nytimes.com 

www.myspace.com 

www.google.com 

 

1. Go to http://www.websiteoptimization.com/services/analyze/ and enter the URL for the site 
assigned to you for analysis. Review the results and the analysis, and summarize the elements 
that need optimization on your assigned site: 

 

 

 

 

2. List at least three ways you would modify elements on the site to improve performance: 

 
 
 
 
 
 
 
 
 
 

Website Optimization Checklist 
Use the following checklist to help you optimize your client website: 

 Compress images. 

 Make pages as small in file size as possible. 

 Avoid redirects when possible. 

 Make sure HTML coding is clean. 

 Minimize the number of total objects on each page. 

 Minimize the number of multimedia elements on each page. 
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Student Resource 12.4 

Checklist: FTP 

Student Name:_______________________________________________ Date:___________ 

Directions: As your teacher demonstrates the FTP uploading process, take notes below. You will then use 
this checklist to transfer your client website files to a web server. 

Using FTP to Transfer Files to a Web Server 
FTP functions allow web designers to access file servers through File Transfer Protocol (FTP). You can 
use specific FTP software or you can access an FTP server directly within a browser. When using a 
browser for FTP, you will use a URL that begins with ftp instead of http. You will need a login ID and 
password to enter the FTP site to upload your files. A web browser can navigate an FTP server just like 
any other file system—with hierarchical folders and files. Through the browser, you can upload, 
download, rename, or delete files from the FTP server. Use the following steps to upload your client 
website to your web server: 

1. Launch the browser. 

 

2. Type in the FTP address:  

 

3. Log in with your user ID and password: 

  

4. Navigate to the server:  

 

5. If the FTP address takes you to the root server, use the instructions sent to you by the web host to 
navigate to your local content directory. 

 

6. Drag and drop or copy and paste the files from your local directory to the FTP server. 

 

7. Check that all files have accurately transferred by making sure the total file size matches. 

 

8. Open up a separate browser window and type in your URL. 

 

9. Determine if your site downloads rapidly. 

 

10. Check every page of your site in the browser to see if all elements are displaying properly and all 
links work. You can use a tool like Online Broken Link Checker (http://www.brokenlinkcheck.com/) 
to check all the links on your website and get a report of any broken links. 
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Student Resource 12.5 

Reading: Creating a Website Maintenance Plan 

Directions: Read the following information, and then use Student Resource 12.6 and work with your group 
to formulate a maintenance plan for your client’s website. 

Ongoing maintenance of a website is often overlooked in the website design process. Many web 
designers do not budget or plan for maintaining the site they have just created. But in fact, maintenance is 
a critical part of web design, and it begins the minute a site launches. 

Most websites are living, breathing entities that need updates and changes over time—they are never 
truly done. Some websites are created using content management systems or blogging sites, in which 
case clients or individuals can edit the content themselves. Work on these sites may not involve HTML 
coding, but such sites do need continual updates and maintenance. 

Your role as the web designer is to determine what the needed changes are, who will make them, when 
they need to be made, and how they will be made and tested. A maintenance plan is a tool used to 
describe each of these elements. 

There may be timely content that needs to be refreshed frequently, or a client may want to continually add 
fresh content to keep users coming back for more. To keep track of desired changes, an editorial 
schedule should be created. There may be user feedback after a site launches, or additional bugs may be 
found. A client may want to expand the amount of content or the number of pages on the site as the 
business grows. So the plan should account for how often and by whom updating content and 
subsequent website testing will be done. At some point the site may begin to look dated or the company 
may change its branding, so the site will have to adapt as well. A client may decide he wants more bells 
and whistles on the site. How often is the client willing and wanting to do a full site “redesign”? Your 
maintenance plan should address all of these possibilities. 

An important part of site maintenance is protecting the site from hackers. Because websites are hosted in 
what amounts to public spaces, there are always automated “spiders” looking to see if installations have 
vulnerabilities they can exploit to remotely install software to hijack the site or promote nefarious products 
or activities. The danger is minimal with a simple HTML site, but as the client’s site grows more complex 
and/or uses content management systems or complex scripting, it is critically important to ensure any 
third-party software you use is kept up-to-date. 

Finally, your plan should indicate how the maintenance will take place. The site is now live, so changes 
and client approvals will have to be done in a testing or local area and then, using proper version control, 
uploaded to the live site when they are ready. 
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Student Resource 12.6 

Outline: Website Maintenance Plan 

Directions: Working with your culminating project group, create a maintenance plan for your client’s 
website. Complete the following plan outline, basing your responses on what you learned in the reading 
(Student Resource 12.5). Your plan should be about one to two pages long. See the example 
maintenance plan on the following page for guidance. 

Roles 

 Website Maintenance Manager (manages scheduling, client contact, client approvals): 

 Client Project Manager (key point of contact at client office; provides approvals, etc.): 

 Content Editor (responsible for making changes to or adding content to the website): 

 Programmer (responsible for bug fixes, site upgrades, revisions, etc.): 

 Tester (responsible for testing all changes and upgrades prior to client review): 

Process 

 The process we will use to find and fix bugs, gain client approval, and upload changes to the live 
server is: 

Editorial Schedule 

 Specific web page, content to be changed or added, author, and date required: 

 Specific web page, content to be changed or added, author, and date required: 

Upgrade Schedule 

 Version 2.0:  

o Description of modifications and feature additions: 

o Estimated release date: 

 Version 3.0 (etc.): 

Make sure your maintenance plan meets or exceeds the following assessment criteria: 

 The plan clearly explains the procedures for handling the following: 

o Managing ongoing maintenance of client’s website 

o Making necessary modifications 

o Testing the site after modifications are made 

o Making fixes needed when new bugs are found 

 The plan provides a concise editorial schedule for content updates, identifies the parts of the 
website that need regular updates or additions, and states who is responsible for providing the 
content. 

 The plan provides any known information and possible release dates for site redesigns or feature 
additions. 

 The plan describes where the site modifications and testing will take place and who is responsible 
for approvals and uploading the changes to the live server. 

 The plan is well organized and clearly written, with no spelling or grammatical errors. 
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Example: Maintenance Plan for FairTeacherGrading.com 
 
Roles: The following people will be responsible for maintaining and upgrading the website. 

 Website Maintenance Manager: Sally Jackson 

 Client Project Manager: Bruce Waters, VP Product Development 

 Programmer: Angela Frost 

 Tester: Joey Sanchez 

Process: The following process will be used to maintain the website. 

 First day of each month: Sally Jackson solicits all new or updated content needed from authors. 

 5th of the month: All new or updated content is submitted to Sally Jackson for formatting, editing, 
and layout into web page format. 

 8th of the month: Sally Jackson submits new or updated content to Bruce Waters for approval and 
feedback. 

 10th of the month: Bruce provides feedback and Sally makes needed modifications. 

 12th of the month: Sally provides new content to Angela Frost to upload to the testing server. Joey 
Sanchez conducts testing on all new content and elements within the site and reviews any 
comments or bugs reported by users. Joey then works with Angela Frost and Sally Jackson to 
make any necessary modifications to new or existing content. 

 15th of the month: Angela uploads the modified and new content to the live server. 

Editorial Schedule: The following pages will be updated on a continual basis. 

 On the 15th of every month, the newsletter page will be updated with new content. The content for 
the newsletter will be provided by various authors from the web development team and within the 
company, and will be submitted to Sally Jackson by the 5th of the month. Sally will edit the content 
and gain approval from Bruce Waters by the 8th. She will then submit the content to Joey 
Sanchez for testing on the 12th of each month, and for uploading on the 15th by Angela Frost. 

 On the 15th of every month, the home page will be updated with new headlines, news, or current 
events. Sally Jackson will select the home page content by the 5th of the month and distribute the 
content for approval by Bruce Waters. She will send the updated home page content to Joey 
Sanchez for testing on the 12th of each month, and for uploading on the 15th by Angela Frost. 

 On the 15th of every two months, the Events page will be updated with a new two-month calendar. 
Events and information will be provided by various company staff members and will be submitted 
to Sally Jackson by the 5th of the month. Sally will edit the content and gain approval from Bruce 
Waters. She will then submit the calendar to Joey Sanchez for testing on the 12th of each month, 
and for uploading on the 15th by Angela Frost. 

Upgrade Schedule: The following is a known redesign or upgrade. 

 Version 2.0: The company intends to complete an upgrade of the website (Version 2) in 
approximately six months. The upgrade will include the new company branding, which is now in 
the works, a searchable database of teachers, a blog for users, and the ability to print PDF admin 
reports on each teacher. Meetings to begin the redesign process will begin in September, and the 
target release will be in December. Sally Jackson and Bruce Waters will kick off the process at the 
beginning of the school year. 
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Student Resource 13.1 

Student Presentations: Attracting Traffic  

Directions: The best website in the world won’t do you or your client any good unless people are using it. 
So how do you attract people to your site and keep them coming back often? Step one is to build a great 
website—which, of course, you have done. Next, you must attract visitors to your site and retain their 
interest once they are there. Your teacher will assign you one of the four topics listed below, and you and 
your group will prepare an eight-minute presentation on the topic and present it to your class. Review the 
assessment criteria at the end of this resource before you begin work. 

Guidelines for Your Presentation 
 Use the tips below to research your topic online. Make sure the sources that you consult to find 

information are recent. As the web grows and develops, strategies for attracting traffic change, 
and the information you present to the class needs to be up-to-date. 

 Plan to use a computer and an LCD projector to show supporting examples about your topic from 
the Internet. You may use presentation software such as Microsoft PowerPoint, but it is optional. 

 Make sure your presentation is clear and organized and does not exceed eight minutes. 

 Make good use of teamwork and cooperative effort to prepare for and conduct the presentation. 

Research Tips 

Group 1: Driving Traffic to Your Website 

Web traffic refers to the number of visitors to a site and the number of pages those people visit on the 
site.  

 Demonstrate how online marketing tools, such as newsletters, tips, event calendars, articles, 
blogs, or discussion groups, can help drive traffic to a site. 

 Demonstrate how tools such as polls, contests, RSS, and calculators can make a site “sticky.” 

 Show examples of a simple domain name and how it can be used effectively in offline marketing 
materials such as ads, magazine articles, business cards, brochures, and so on.  

 What is a reciprocal link and how can it help build site popularity? 

 What is a favicon and how can it attract visitors? 

 Describe how a “cost-per-click” service such as Google AdWords works. 

 Show examples of and explain the pros and cons of banner ads, pop-up ads, and bulk emails. 

 

Group 2: Search Engine Optimization 

Search engine optimization (SEO) refers to efforts to improve a website’s performance with search 
engines in order to improve the volume and quality of visitors to the website.  

 Discuss typical user actions when faced with a long list of search engine results, and explain why 
getting proper placement on search engines is as important as the website itself. 

 Explain how a search engine has spiders that “crawl” the web to index and rank new web pages, 
and show how you can actually register your site with various search engines (e.g., 
https://www.google.com/webmasters/tools/submit-url). 
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 Demonstrate the proper way to write a title tag in HTML code (concise, no more than 40–60 
characters, placed above the description, etc.), and demonstrate a proper description meta tag in 
both the HTML code and on a search engine results page.  

 Discuss how reciprocal links affect search engine ranking (the more sites that link to you the 
better, but the more sites that these sites also link to, the worse for your site). 

 What are Google Penguin and Google Panda, and how do they affect SEO? 

 What is keyword density and how does it affect the rank of a page? How does keyword placement 
affect the rank of a page? What is the best approach to using keywords? 

 

Group 3: Building Online Credibility 

Online credibility is what leads web users to believe in and trust the content found on a website, and 
therefore return to that site. 

 Demonstrate ways that websites can easily allow users to verify the accuracy of the information on 
a site (citations, references, links, dates of review or update, etc.). 

 Find examples of websites that offer the most interesting content above the fold. 

 Compare how a professional-looking and easy-to-use site appears much more credible than a 
confusing, unprofessional site. 

 Why does having experts and partners with appropriate credentials, as well as an affiliation with a 
real organization, help users assign credibility to a site? 

 Find a site with errors or inaccuracies, and show how even the smallest errors can hurt credibility. 

 Show examples of good contact pages and how providing multiple means of contact (phone, 
email, mail, feedback forms) can boost credibility. Demonstrate how to place a mailto link within 
the HTML code. 

 Why can too many ads, offers, and so forth be annoying to users and cost a site credibility? 

 Demonstrate a group or a forum such as Google or Yahoo! Groups. Explain how adding a forum 
to a site can help build online credibility as well as attract and retain visitors. Also explain the 
potential negative impact of forums or blogs that are not kept up-to-date. Actively building that 
community is a full-time job, in many cases. 

 

Group 4: Gathering and Tracking Site Statistics 

Website statistics provide information about the users of a site—which page they go to most, which 
page they spend the most time on, which page they enter the site from, and so on. 

 Explain what information is contained on a web server log (e.g., time and date visited, duration of 
stay, entry point, browser type, referring websites, page views, etc.). 

 Who usually provides the web tracking software for a site? Show some examples of web hosting 
companies who provide this service. 

 Demonstrate how a log analyzer formats the server data into useful tools, and how those tools 
may affect how a web designer modifies a site. 

 Describe how a hit is calculated (for each file within a page). 

 How could viewing statistics on a “top path” help improve a website’s usability? 

 In what ways can you leverage Google Analytics to analyze traffic?
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Make sure your presentation meets or exceeds the following assessment criteria: 

 The presentation clearly defines the topic area and covers each of the research tips provided. 

 The presentation shows examples of websites that do and do not demonstrate success in the 
topic area. 

 The presentation gives a correct demonstration of technical tasks and coding needed to 
implement the techniques covered. 

 The presentation clearly explains the potential benefits and risks of implementing the techniques 
covered. 
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Student Resource 13.2 

Note Taking: Attracting Traffic 

Student Name:_______________________________________________ Date:___________ 

Directions: During the group presentations, take notes on each topic area below. You will use your notes 
in an upcoming class period to help create a plan for attracting traffic for your client. 

Driving Traffic to Your Website 

Definition:  

 

Results expected (traffic, user experience, etc.):  

 

Techniques: 

 

Site modifications needed to implement:  

 

Search Engine Optimization (SEO) 

Definition: 

 

Results expected (traffic, user experience, etc.):  

 

Techniques: 

 

Site modifications needed to implement:  
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Building Online Credibility 

Definition: 

 

Results expected (traffic, user experience, etc.):  

 

Techniques: 

 

Site modifications needed to implement:  

 

 

Gathering and Tracking Site Statistics 

Definition: 

 

Results expected (traffic, user experience, etc.):  

 

Techniques: 

 

Site modifications needed to implement:  
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Student Resource 13.3 

Assignment Sheet: Plan for Attracting Traffic 

Directions: Join your culminating project group and formulate a plan for attracting traffic to your client’s 
website, using your notes from the presentations. Each member of your group should serve as a 
reference for the part of the plan he or she researched and presented. Review the assessment criteria at 
the end of this resource before you begin work. 

Guidelines for Your Plan 
 Your plan should be about two pages long.  

 Use the prompts listed below as an outline for each paragraph in your plan. 

 Make sure that your plan suggests various tasks your client can perform, the potential results, and 
specific instructions for implementation.  

Plan Outline 
Overview: (why your client needs a plan to attract traffic to the site) 

Driving Traffic to Your Website 

 Description: (define why this is relevant to your client) 

 Expected results: (impact on traffic, user experience, etc.) 

 Recommendations: (explain the changes that the client should make) 

 Implementation: (describe in detail the changes needed on the site, the marketing pieces that 
need to be developed, the new software or services that need to be purchased, etc.) 

Search Engine Optimization (SEO) 

 Description: (define why this is relevant to your client) 

 Expected results: (impact on traffic, user experience, etc.) 

 Recommendations: (explain the techniques that the client should implement) 

 Implementation: (describe in detail the changes needed on the site, the marketing pieces that 
need to be developed, the new software or services that need to be purchased, etc.) 

Building Online Credibility 

 Description: (define why this is relevant to your client) 

 Expected results: (impact on traffic, user experience, etc.) 

 Recommendations: (explain the changes that the client should make) 

 Implementation: (describe in detail the changes needed on the site, the marketing pieces that 
need to be developed, the new software or services that need to be purchased, etc.) 

Gathering and Tracking Site Statistics 

 Description: (define why this is relevant to your client) 

 Expected results: (impact on traffic, user experience, etc.) 

 Recommendations: (explain the changes that the client should implement) 

 Implementation: (describe in detail the changes needed on the site, the marketing pieces that 
need to be developed, the new software or services that need to be purchased, etc.) 
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Make sure your plan meets or exceeds the following assessment criteria: 

 The plan provides thoroughly researched recommendations for driving traffic to the website.  

 The plan provides clear recommendations for search engine optimization.  

 The plan clearly explains recommendations for building online credibility.  

 The plan provides clear and complete recommendations for gathering and tracking site statistics. 

 The plan is well organized and free of spelling and grammatical errors. 
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Student Resource 14.1 

Reading: Web Industry Employment Overview 

Nowadays, it seems as though almost every company and every person has a website. If you have 
experience with website creation, your employment prospects are terrific. There are plenty of jobs 
available for people with the right education and skills. 

According to Salary.com, the median salary for a web designer was $60,866 in 2011. A web administrator 
earned an average of $73,793 annually in 2011, and a senior web developer earned an average of 
$76,691 annually in 2011. 

Types of Employment 
If you work in the web industry, you will have several different options for employment. You may choose 
to work for a specific company, developing and maintaining its website. In that situation, it’s important to 
choose a company whose products you enjoy or believe in.  

If you work for a consulting firm or as a freelancer, you may be handling projects and assignments for 
many different companies in many different industries. A consultant may work at a firm with other 
consultants, while freelancers work for themselves. In this situation, it is even more important to be good 
at handling many different projects at the same time. Being a consultant or a freelancer basically means 
you have several different bosses, or clients, at once, and you have to stay on top of projects for different 
businesses simultaneously. 

Specializations within the Web Industry 
Once you have determined which type of employment situation you would enjoy most, you need to think 
about what kind of job you’d like to have and whether it best suits your skills and personality. Some of the 
most common web industry jobs are described below. 

Web Designer: A web designer is typically responsible for the overall look and feel of a website. Web 
designers need to understand graphic design but also be able to work on a site’s functionality. They may 
work with colleagues or clients to develop the initial concept for a website, or that concept may already be 
decided on and then given to them to implement. Designers may use HTML or WYSIWYG tools to build 
the site, or work with others who will do the coding. Since designers need to listen to their clients or 
colleagues and then create a site based on that information, they need strong listening, verbal, and visual 
communication skills. They also need to be flexible and willing to revise their designs, and work well 
under pressure. A web designer needs a background in fine arts or graphic arts as well as an 
understanding of computers and programming for the web. An associate’s or bachelor’s degree may be 
helpful but is not always necessary. 

Information Architect: Information architects, sometimes also called user experience designers, literally 
plan out how to present a website to the user. Their behind-the-scenes work may not be obvious to 
everyone, but it is very important. They develop a plan to make sure the website meets a company’s 
goals. They may also analyze the site’s audience, identify the audience’s needs, and make sure the site 
design meets those needs via testing and focus groups. They may also lay out the site’s architecture, 
which can be used as a blueprint on which all other site design decisions are based. They need a strong 
knowledge of user interface design, web design, website architecture, and site navigation. In general, 
information architects need a bachelor’s degree in computer science or a similar field. They also need 
good communication skills and an ability to work under pressure. 
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Webmaster/Developer: Webmasters are responsible for the ongoing maintenance and development of a 
website. They may also be involved in the initial development of the site. They make sure the site looks 
and functions correctly on a variety of different computers. They make sure the site loads quickly, they 
update the site, and they fix any bugs on the site, such as broken links. They may also be in charge of 
deciding what kind of computer and software will be used to develop the website and what hosting 
company to use, and therefore must understand the variety of web software and service options 
available. Some webmaster jobs will be available to people with an associate’s degree, but for the more 
complicated jobs, the higher paying jobs, or the supervisory jobs, a bachelor’s degree is needed. 

Project Manager/Producer (PM): Project managers or producers are responsible for planning, 
budgeting, scheduling, and tracking an entire web project. They must keep all members of the web team 
on the same page and be sure everyone is always on time and on budget. They must also continually 
balance the needs and expectations of the client with the budget and goals of the site. The PM needs to 
be able to communicate effectively with a client about the timeline and budget, as many clients decide 
they want new features and functions beyond what was originally scoped for the project. It is the role of 
the PM to keep the objectives, milestones, resources, and costs clear for all members of the team as well 
as for the client. Website project managers typically have a few years’ experience in other web team roles 
and/or management roles. 

Future Jobs in the Web Industry: Web design and development is an ever-changing industry, and as 
technology grows and develops, so do the job descriptions. As soon as Web 2.0 was out, Web 3.0 began 
developing. There are varying definitions of what phase three of the web will be, but the majority of 
theories focus around a user-centric approach. A whole new era of the web industry will open with the 
advent of Web 3.0. More user-centric applications will be developed, more features will be customizable, 
and emphasis will be on user engagement. For web designers, this means a much higher focus on user 
interface design. Today, we have web professionals that specialize in user interface (UI) design, but not 
all web professionals have a strong knowledge of it. In the future, you will see a lot more web 
professionals learning how to create websites that are more adapted to the user perspective, and the flow 
throughout a website will be enhanced. The latest web browsers and other online gadgets have all begun 
to utilize HTML5 and employ the wide range of functional additions that this new standard offers. You are 
also likely to see improvements in JavaScript, CSS, and more. Finally, the web is no longer limited to a 
computer screen; displaying web pages on mobile devices and tablets is clearly a trend that will continue 
to develop.  

Getting Started 
Any career in the web industry requires a certain level of computer expertise and a familiarity with a range 
of web design, programming, and graphic software. In addition to taking AOIT courses, you can get a 
part-time job or an internship or even volunteer your computer skills to build experience. Many IT 
companies offer internship programs, and many non-IT companies and not-for-profit organizations need 
help with their websites. 

Communication skills are also very important, especially the ability to explain IT information to people who 
are not computer literate or less computer literate. 

Website creation is an interesting combination of technical and graphic design skills, so it’s important to 
have some training or experience in computer graphics as well. Many designers create an online portfolio 
of their work to show prospective employers. You’ve already created one website that you could include 
in your portfolio. By building websites for friends, family members, organizations, or local businesses, you 
can create an outstanding portfolio that will make you a strong candidate for an entry-level job in web 
design. 

The web industry is dynamic, and change happens quickly. It’s important to keep up with the latest 
technology trends and to learn new standards. Having a solid network of teachers, mentors, and others in 
the industry is key to staying current. Many web professionals keep up-to-date by following online blogs 
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(http://www.smashingmagazine.com), by participating in online design/development sharing groups 
(http://codepen.io/about), or by listening to industry-related podcasts (http://shoptalkshow.com/). You may 
even try joining a local web designer Meetup group (www.meetup.com).  
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Student Resource 14.2 

Wish List: Interesting Jobs 

Student Name:       Date:    

Directions: Using Student Resource 14.1, Reading: Web Industry Employment Overview, write down at 
least three jobs that you read about that you might want to do. Then write down why the job interests you 
and include at least two or three examples of skills, knowledge, and personal characteristics a person 
needs in order to succeed in that job. 

Job Title Why It Interests Me 
Skills, Knowledge, or Personal 
Characteristics Needed 

Example: Movie Star 

 

Example: I’d like to be famous and make a 
lot of money, and I like movies. 

Example: Have extensive 
professional training in acting 

Look good on camera 
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Student Resource 14.3 

Reading: Writing an Effective Cover Letter 

Overview 
A cover letter is a letter that you write to accompany your resume when you are applying for a job. Its 
purpose is to thoroughly explain your interest in the position and highlight the skills that make you a good 
match. A cover letter is your opportunity to give the employer specific information about what you can 
contribute to his or her company or organization. Employers usually look for well-written cover letters to 
screen out applicants who are not sufficiently interested in the position or who lack the required writing 
skills. 

Format of a Cover Letter 
Your Name 
Street Address 
City, State Zip Code 
Telephone Number 
Email Address 
 

Month, Day, Year 

Mr./Ms./Dr. FirstName LastName 
Title 
Name of Organization 
Street or PO Box Address 
City, State ZIP Code 

Dear Mr./Ms./Dr. LastName: 

Opening paragraph: Explain why you are writing and how you learned of the organization or position. 

Second paragraph: State why you are interested in the position and/or the company. Show that you know 
enough about the company or position and show how your background is relevant. Mention specific 
qualifications and/or experience that make you a good fit. Explain in more detail relevant items in your 
resume. Mention that your resume is enclosed, as well as any other enclosures, such as references, if 
applicable. 

Concluding paragraph: Indicate that you would like the opportunity to interview for the position. State what 
you will do to follow up, such as telephone the employer within two weeks. If you will be in the employer’s 
location and could offer to schedule a visit, indicate when. State that you would be glad to provide 
additional information as needed. Thank the person for his or her consideration. 

Sincerely, 
(Your handwritten signature) 
Your name typed 

Enclosure(s): resume 
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Tips for an Effective Cover Letter 
 If at all possible, address your letter to the specific person who is doing the hiring. You can often find 

this information with a little research. If not, it is appropriate to write “Dear Hiring Manager.” 

 Say how you learned about the position or the organization and explain why you are applying for a 
job. Be specific. Example: “I am looking for an entry-level position in the web industry and saw your 
advertisement in The Cincinnati Ledger.”  

 If you learned about the position through someone in particular, or if someone recommended that you 
apply, mention that. It is a way to immediately tell your reader that other people believe that you are a 
good potential hire. Example: “My Internship Supervisor, Ann Lucasio, is very familiar with your 
company and encouraged me to apply for your opening as an assistant producer.”  

 Call attention to elements of your background—education, leadership, experience—that are relevant 
to the position you are seeking. Be as specific as possible. Example: “The courses I have taken in 
website creation at Skowheegee High School have given me a good understanding of what it takes to 
be an effective web professional. My experience working the IT help desk for the past three summers 
has given me valuable experience as well.” 

 Reflect your attitude, enthusiasm, and communication skills. Remember that this may be your only 
opportunity to stand out in your quest for getting an interview. Example: “I thrive on the busy 
environment of a successful web business. Even the most hectic days at the help desk were exciting 
to me because I like to challenge myself to keep calm and collected no matter what.” 

 Provide or refer to any information specifically requested in a job posting that might not be covered in 
your resume. For example, include the date you will be available to start work, or make a reference to 
a writing sample that you have included, if the potential employer has requested one. 

 Indicate what you will do to follow up. Example: “I hope to hear from you by next week and will phone 
your office on Friday to make sure you have received my application.” 

 Do not let even one spelling or grammatical error slip through. Review your letter multiple times and 
have at least one other person proofread it. 

 Have current references lined up to vouch for you. Past employers, teachers, and current colleagues 
would be appropriate people to recommend you for a job. Make sure that these people know that they 
may be contacted. 
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Student Resource 14.4 

Analysis: Cover Letter Example 

Student Names:_________________________________________________ Date:______________ 

Directions: Review the following cover letter, which is tailored to the job description on the following page. 
With a partner, make notes in the margin next to each element of the letter and highlight any phrases or 
sections that make the letter particularly effective. 

John Lamont 
55 Ellsworth Dr. 
Boston, MA 02108 
(555) 723-8943 
johnjohn@bu.edu 

July 3, 2013 
 
Dr. Emma Johnson 
Principal, Warren Elementary School 
101 Beluga Rd. 
Warren, MA 01083  

Dear Dr. Johnson: 

From your company’s website, I learned about your need for a fourth grade teacher in the coming school 
year. Having grown up in the Warren area, I’m very interested in teaching at your school. I have recently 
completed my Bachelor of Science degree in Family and Child Development with a concentration in 
Elementary Education at Boston University, and I will be available for employment in August. I have 
enclosed my resume for your consideration. 

The teacher preparation program at Boston University includes a full academic year of student teaching. 
Last semester I taught second grade and this semester, fourth grade. These valuable experiences have 
afforded me the opportunity to develop lesson plans on a wide range of topics, for varying levels of 
academic ability; to observe and participate in effective classroom management approaches; to assist 
with parent-teacher conferences; and to complete in-service training on diversity, math and reading skills, 
and community relations. 

I have also spent the past three years tutoring third, fourth, and fifth graders in math, reading, and science 
in an after-school program designed for at-risk youth in inner-city Boston. This gave me a unique 
opportunity to work with an ethnically and culturally diverse population. It also helped me identify ways to 
customize the mainstream curriculum to meet these children’s needs. Many of the children needed their 
unique learning styles to be addressed. By providing this to them in a more intimate setting, I helped them 
see that success was well within their reach. 

I look forward to putting my knowledge and experience into practice in the public school system. Next 
week I will be in Warren, and I will call you before my arrival in the hope of setting up an interview. I can 
be reached before then at (555) 723-8943. Thank you for your consideration. 

 
Sincerely, 

 
John Lamont 

Enclosures: resume, district application 
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Job Description 
Position: Fourth Grade Teacher 

Date Posted: July 2, 2013 

Commitment: Full-Time 

School Year: 2013–2014 

Requirements: 

 Must be state-certified to teach elementary ed.  

 Bachelor’s degree or higher 

 Minimum one year of student teaching  

Qualifications:  

 Sincere desire to work in an outstanding elementary school and to commit to the learning and 
growth of elementary students 

 Ability to work collaboratively with grade-level team members  

 Strong desire to grow professionally in a learning community 

 Bilingual and/or working with diverse populations a plus 

How to Apply: Please send letter of interest, resume, and completed district application to:  

Dr. Emma Johnson 
Principal 
Warren Elementary School 
101 Beluga Rd. 
Warren, MA 01083 
ejohnson@warrenelem.edu 
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Student Resource 14.5 

Writing Assignment: Cover Letter 

Student Name:__________________________________________ Date:________________________ 

Directions: Read the job descriptions on the following pages and select the web industry job you would 
like to apply for based on your interests, qualifications, and experience. Then use the chart below to make 
a list of the requirements and/or qualifications the employer is looking for in the ideal candidate, and list 
all of your own qualifications and experience that might match what they are looking for in the right-hand 
column.  

Use the information in your chart as a basis for your cover letter. Remember to follow the cover letter 
format in Student Resource 14.3. Also, you may want to refer to the notes you took during the guest 
speaker’s visit. Before you start writing, be sure to review the rubric for a good cover letter that your 
teacher gives you. 

What the Employer Is Looking For What I Can Offer 

Example: Self-starters who can take initiative on 
projects 

 

Example: I took the lead in organizing the costumes 
for the school play, and it was a great success.  
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Job #1: Game Site Webmaster 

We are a small, leading game company in business for over 10 years. We update our web content every 
day.  

We are looking for a contractor to start immediately, half-time or full-time. If it works out, it can turn into a 
permanent position. Candidates should be:  

 Very responsive to emails. Completely reliable.  

 Competent working with HTML/CSS and have the necessary tools already.  

 Comfortable working remotely and self-motivated.  

 Available, at least for an hour, 7 days a week. Available all day on Fridays.  

 Decent at written English.  

Experience with some of the following would be a bonus:  

 Subversion  

 PHP  

 Perl  

 Ruby on Rails  

 Graphics editing/creation  

This is a telecommuting position only. So that we can occasionally meet face-to-face, local candidates are 
strongly preferred. 

 

Job #2: Web Business Manager 

We are seeking an all-around web business manager to coordinate the various business and marketing 
needs for two small, exciting Internet start-ups focusing on alternative health and medicine. You will 
receive the many benefits and rewards of being in a hot, new underwritten company.  

Job Tasks:  

 Manage website development with contract web design firms  

 Compose e-newsletter campaigns and develop contact database system  

 Ensure timely and accurate web updates  

 Develop marketing partnerships and advertising campaigns 

 Manage sales and customer service  

 Handle any legal and intellectual property needs  

 Oversee various start-up business needs that may arise  

Qualifications:  

 Proven experience in the tasks required  

 Bachelor’s degree  

 Mac and Internet proficiency; HTML, Photoshop, and web editing software skills  

 Understanding of multichannel marketing, usability, and target audience  

 Ability to keep current on creative design, marketing, and online trends 
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 Extensive interest and knowledge of alternative health and personal development market  

 Be motivated, highly organized, self-starting, collaborative, flexible, and detail-oriented  

 Have great sense of humor, as well as discipline and appropriate sense of urgency  

Please don’t apply if you don’t meet most, if not all, of these requirements. Pay is negotiable based on 
experience level. Hours vary from 20 to 40 per week. 

 

Job #3: Web Developer, Corporate Intranet 

We are the world’s first and largest specialized staffing firm. We are looking for two creative and energetic 
web developers to build portlets/widgets, maintain content, and implement presentation elements for our 
global intranet services team. Our group partners with IT to implement solutions using Vignette, 
SharePoint, open source applications, and Web 2.0 technologies. Developers are expected to collaborate 
and contribute ideas toward objectives in line with our longer-term enterprise portal vision and strategy. 
The responsibilities include interaction with business stakeholders and end users, documenting 
requirements, and participating in QA testing.  

Qualifications:  

Most importantly, we are looking for self-starters who can take initiative on projects, exhibit strong 
problem-solving abilities, and learn new software quickly. Interaction with business, IT, and end users is 
required for these positions, so strong verbal and written communication and team collaboration skills are 
a must. We are seeking people with a bachelor’s degree or equivalent and 3+ years’ experience in web 
development. Experienced users of Web 2.0 social technologies (such as having active accounts on 
Facebook and LinkedIn, maintaining personal blog or website, managing photos on Flickr, posting videos 
on YouTube, using Twitter, etc.) are highly desired.  

Technical skills include:  

 Strong XHTML, CSS, JavaScript and JSP coding skills, ability to modify code without WYSIWYG 
HTML editors, and best practices  

 Familiarity with Web 2.0 technologies (Ajax, Web Services, etc.)  

 Familiarity with modern accessibility techniques (semantic markup, unobtrusive JavaScript, etc.) 
and Web Internationalization (i18n) standards  

 Familiarity with search applications and search optimization  

 Experience with XPath and writing XSL Transformations is a plus  

 Experience with enterprise portal technology and/or content management systems (especially 
Vignette) is a plus 
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Student Resource 15.1 

Feedback Form: Website Fair 
Project:      Students:       

 

Would you hire this group to build a website for you? Why or why not? 

 

 

 

What is your first impression of this website? 

 

 

 

List three things that were done really well on the website. 

1.  

2.  

3.  

 

List three things you think this group could have done better. 

1.  

2.   

3.  

 

Was the group able to answer your questions effectively? Give an example. 
 

 

 

 

 

Thanks for participating in this Website Fair and for giving us your feedback. Please submit this form to 
the class teacher before you leave. 
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